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Introduction

Introduction

What is Grasshopper?

Grasshopper (GH) is a node-based algorithm editor integrated with Rhino modeling tools.
Algorithms are used to describe logical relationships among design parameters that define the
parametric model. Through algorithms, the user is able to establish a set of rules that define the
sequence of operations, thus aiding the design process.

What is the purpose of the Grasshopper-ARCHICAD Live Connection tool?

The Grasshopper-ARCHICAD Live Connection offers a unique, algorithm-based workflow, which
helps you explore a large number of design variations and create and fine-tune building details and
structures - without exchanging files.

Key features and benefits

e Translate simple geometry created in Rhino into BIM construction elements
e Bi-directional connection — no need to export/import file for data exchange
e Dynamic (live) connection while editing

e Direct and simultaneous graphical feedback from both Rhino and ARCHICAD

Supported workflows

This set of tools enables Rhino/Grasshopper (GH) and ARCHICAD (AC) to communicate directly.
Designers working in either Rhino/Grasshopper or ARCHICAD can utilize its functionality to their
advantage. Users can start the design process in either work environment (AC or RH or GH). In each
case, the user will select an original set of reference geometries to be manipulated via
Grasshopper, or create it from scratch in Grasshopper.

e “Start with pure 3D geometry” workflow: Designers start with the design geometry using
Rhino and Grasshopper. With the “GH-AC Connection” tool, they can dynamically generate a
BIM model consisting of ARCHICAD construction elements, and update the resulting BIM model
directly from Grasshopper.

o “Start with intelligent building elements” workflow: Designers start with the design in ARCHICAD
and extend their AC toolbox with algorithmic design methods applied to AC elements. In this
workflow, input reference geometries (reference points, curves and other parameters) are taken
directly from ARCHICAD and used in Grasshopper, without interaction in Rhino.

Scope of the manual

This manual is intended to explain only the added functionality of creating ARCHICAD elements
from Grasshopper. The general description of functionality of ARCHICAD, Grasshopper or Rhino is
not in the scope of this manual. To acquire the necessary basic knowledge in these applications,
please visit the following sites.

e Grasshopper Training Center: http.//www.grasshopper3d.com/page/tutorials-1

e ARCHICAD Training Materials:_http.//www.graphisoft.com/learning/training_materials/

e Rhinoceros3D Learning Center:_http://www.rhino3d.com/learn
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Getting Started

Getting Started

To achieve a connection between the ARCHICAD and Grasshopper applications, you must install a
GRAPHISOFT extension: the Grasshopper — ARCHICAD Live Connection.

Install the Add-On

1.
2.

Make sure that ARCHICAD 22 (latest update) is already installed on your computer.

Make sure that no other version of Grasshopper-ARCHICAD Live Connection is already installed!
If you already have one (e.g. a previous version), you must uninstall it before proceeding.

Make sure that Rhino is installed on your computer.

— Windows: Use Rhino Version 5 or Version 6, 64-bit

— Mac: Use Rhino Version 5, 64-bit

Important: Grasshopper for Mac is currently at a “Work in Progress” stage of development. It
does not yet contain all of the features available in Rhino for Windows. For details, see:
https://www.rhino3d.com/mac-feature-compare.

Launch the Setup Wizard of the Connection add-on and go through the steps as shown on the
setup screens.

Launch the Applications

1.
2.
3.

Grasshopper-ARCHICAD Live Connection 2.2 User Guide

Launch ARCHICAD.
Launch Rhinoceros 3D (Rhino).

From Rhino, launch Grasshopper: Type the word “Grasshopper” into the Rhino Command Line
and hit ENTER.


https://www.rhino3d.com/mac-feature-compare
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Notes:

— Once all three applications are running, it is recommended to arrange the windows so that
they do not overlap. (For ease of use, use multiple screens).

— To receive notifications and information from the add-ons, turn on the Status bar palette in
ARCHICAD (Window > Palettes > Status bar).

Start the Connection

e In ARCHICAD, go to File > Interoperability > Grasshopper Connection.

e A small floating palette appears with the “Start Connection” button on it. Click to start the
connection.
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Grasshopper Palette in ARCHICAD

To open the Grasshopper palette in ARCHICAD, go to File > Interoperability > Grasshopper
Connection.

The palette contains 3 buttons:
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Note: Like any other palette in ARCHICAD, the Grasshopper palette is also available from
Window > Palettes.

Grasshopper n
Live Connection: Click to turn on/break the connection between
Grasshopper and ARCHICAD.

Send Changes: Updates Grasshopper about changes made in ARCHICAD. If
this button is activated, then Grasshopper is continuously and automatically
updated based on changes to connected elements in ARCHICAD. This may
take time. To avoid delays during these updates, deactivate the button - in
this case, Grasshopper will not automatically reflect the model changes in
ARCHICAD.

Lock/Unlock GH Elements: Use this control to unlock the elements generated in Grasshopper.
Unlocked elements can be freely modified in ARCHICAD. Click again to lock the elements: now
the elements revert to their status as defined in Grasshopper (e.g. CW Curve Geometry).
However, any parameters that cannot be not set in Grasshopper, and which you set in
ARCHICAD while the elements were unlocked (e.g. a CW Panel’s Building Material), will retain
those ARCHICAD settings even after elements are re-locked.

@ Grasshopper.gh

%, % Break Connection
Send Changes

Ui, Unlock GH Elements

Select in GH: In Grasshopper, selects the nodes which generated the elements currently
selected in ARCHICAD. This button is active only if the current ARCHICAD selection includes at
least one element generated by the Grasshopper code.

Notes:

— If the green icon is spinning, this indicates that the connection with Grasshopper is live, and
ARCHICAD is now ready to send and receive information.
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— The palette also tells you which currently opened Grasshopper document is connected to
ARCHICAD.

— At the bottom of the palette, a green progress bar appears during time-consuming updates.

— Click the info icon at top left to open a palette: this displays Connection Status, the path of
the connected file, and the Port Number. If the selected port is occupied by a different
application, you are prompted (“Set Port”) to choose a different port.

Connection Status: Grasshopper n .. Set Port for Grasshopper Connection ? *
M Communication port occupied by another application!
Connected File: Gx <port occupied>

Connection with Grasshopper could not be established becouse

<no document connected> — the communication port is occupied by an other application.

() set Port...

Port Number:

4;152 L:m § iedls Type and check a port number below in range [40000, 50000, If the selected
occupled: port is available, set the same port in Grasshopper at File > Connect

Document to ARCHICAD.

Send Changes

Select in GH

Port number: e occupied |FEYEE Check
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ARCHICAD Tab in Grasshopper

In Grasshopper, a new “ARCHICAD” tab has appeared on Grasshopper's tab bar. The icons on this
tab resemble those of ARCHICAD tools; they represent Component Nodes, Parameter Nodes and

Input Nodes.
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Command in Grasshopper’s File menu

In Grasshopper, a new command appears in the File menu: “Connect Document to ARCHICAD”. This
command opens a dialog box: among the currently open Grasshopper files, choose the one that

should communicate with ARCHICAD.

Grasshopper - Definition_2 - [m] x
Fle | Edt View Display Sotion Hel Definition_2
[ New Document CirisN bfzce Mesh Intersect Transform Display | ARCHICAD
T = . — I
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Bl Save Document s CiisShiftsS o) @@ 20 Q-
Save Backup Ctrl+Alt+5
é Connect Document to ARCHICAD..
Export GQuick Image Ctr+5Shift+Q
Export Hi-Res Image.
Document Properties
Create User Object.
E Ribbon Layout 3
=
Show In Folder
g8 Special Folders >
Preferences Ctrl+Shift+P
Close Definition_2 Cd+W
[
"
@Masave complete (280 seconds ago) 0.9.0076

Connect Document to ARCHICAD = [m] X

Select the Grasshopper document which should communicate with ARCHICAD (0]

Status  Name Path
:;*-' Definition_3" C:\Users\szabi\Desktop\Uj hiba\Definiti...
Definition_2 C:\Users\szabi‘\Desktop\Uj hiba“\Definttion_2.gh

Definttion_1 C:\Users\szabi\Desktop'Uj hiba"Definttion_1.gh

Port used for Live Connection with ARCHICAD: 41678

o

Preview Option in Grasshopper’s Display Menu

Most components of Grasshopper-ARCHICAD Connection generate a detailed preview in Rhino,
using colors that match those of the ARCHICAD model. However, generated Library Parts (Object,
Window, Door) display only a bounding box as a preview, by default. (Otherwise, the high polygon

count might affect performance.)

Grasshopper-ARCHICAD Live Connection 2.2 User Guide
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To see a detailed preview of Library Parts in Rhino (instead of just the bounding box), turn on the
Detailed ARCHICAD Preview toggle in Grasshopper’s Display menu.
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Uninstall Grasshopper Connection

Uninstall Grasshopper Connection

If you uninstall Grasshopper Connection, make sure you follow these steps - otherwise, you may run
into errors when reinstalling.

Windows

Remove the application using the “Apps & features” utility, accessible from Windows Settings.

Mac (GH Connection for AC22)

1. Go to the ARCHICAD folder where Grasshopper Connection is installed
2. Run the following app: Uninstall.GH

Mac (GH Connection for AC21 and earlier)
1. Go to the ARCHICAD folder’s Add-On\Local folder.

2. Delete the following items from the Local folder:

— GrasshopperConnection
— ProductVersion.xml

3. Go to the following folder: ~/Library/Application Support/McNeel/Rhinoceros/MacPluglins/
Grasshopper/Libraries/ARCHICAD xx (where xx is the ARCHICAD version number)

4. Delete the ARCHICAD xx folder (it contains a file named ArchiCADConnection.gha)
5. Go to the Terminal App window.
6. Copy-paste the following line, then press Enter:

sudo pkgutil --forget "com.graphisoft.ArchiCAD.Goodies.GHACLiveInstaller"

Grasshopper-ARCHICAD Live Connection 2.2 User Guide 11



ARCHICAD Nodes

ARCHICAD Nodes

The ARCHICAD tab page in Grasshopper contains Parameter nodes, Component nodes, and Input
nodes. Parameter nodes store geometric information; components perform the operations that
generate data; input nodes provide access to certain ARCHICAD value sets.

Parameter nodes refer to point coordinates or existing 2D or 3D geometry in the e@@@@
ARCHICAD project. Most of the Parameter nodes represent special ARCHICAD
data that can be interpreted only by other ARCHICAD Components. However, in @@Q@@

the case of Point, 2D Curve, and Spline Parameter nodes, the referenced 0000
geometry can be transformed by regular Grasshopper components (such as @@@
Move) in the usual way, and can also be used as the initial input for GH code.

See details at ARCHICAD Parameter Nodes.

Design and Document components generate native 2D or 3D elements -
in ARCHICAD - such as Polylines, Walls, Objects, and Windows. = E@‘ DH G’L: 7 A8,

22 | o "\IC :) & E]“.
At present, Grasshopper components can interpret output only from the U Eﬁj‘ 3 G&[ |
Spline and 2D Curve components, because these are automatically EEE EFJ:HL % % GO &)

.
converted to the native Grasshopper Curve data type. :

The rest of the ARCHICAD components generate a special type of data that cannot be |%
converted into built-in Grasshopper data types. For this reason, Grasshopper operations |

(such as the Move component) cannot be carried out on the geometry generated by the
AC components. The AC components can be placed downstream from the GH nodes, but

the Grasshopper definition ends there.

Synchronize
4 @ F Curve =3 Beam
\ Curve e Beam Settings
Count f Tangents Synchronize

W © 10 Kinks Parameters Anchor Point

U Celumn
End Point

Column Settings

Curve Points

Count f Tangents
Kinks Parameters Synchronize %

(| Geometry o Geometry Curve % Beam

( Motion Transform Beam Settings

GH Definition AC Components

See more details at ARCHICAD Document Components and ARCHICAD Design Components.

Deconstruct components: These are used to break down 2D and 3D TN o
ARCHICAD elements into their constituent parts. Use e U Lt

G

Deconstruct components are the inverse of the element-generating Design

EUER- I A LU
and Document components. Use Deconstruct components to access the g Lo (e <ot 5
geometry data of the input ARCHICAD elements. A Deconstruct component Sa X I A?:
can also reference an existing, manually placed ARCHICAD element.

See more details at ARCHICAD Deconstruct Components.
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Settings components are available for each Design and Document — =
component. The Settings component sets parameter values for the element t?m ﬂiﬁ ?ﬁm E‘m szn /'\"m
generated in ARCHICAD. Attach a Settings component to the “Settings” 0 B¢ S v
. . A0 A0 A0 0 L0 L0
input parameter of the data-generating component. o g =

A0 A0 A0 L0 A0 A0

MECPnB

Extract Settings components: T
Extract Settings components are the inverse of the Settings components: they ;>L;}%> i} » »
break down the ARCHICAD element Settings data referenced at input. Use I 8 v

il |
Extract Settings components to get these element settings for use in another l'llrlb ( ,.'0 il >3 =
operation. | el B L IESd>

See more details at ARCHICAD Extract Settings Components.

Reshape components can modify elements produced by certain ARCHICAD components %
(Fill, Slab and Roof components). Currently there are two Reshape components: the
Subtract Polygon and the Add Polygon.

See more details at ARCHICAD Reshape Components.

Input nodes: An input node stores a list of values received from ARCHICAD. The — i W o
el Z8] [ EN]
available values are continuously refreshed, so that they always correspond to the

set of values contained in ARCHICAD. At present, twelve input nodes are available:

2D Viewpoint, Composite, Fill Pattern, Line Type, Profile, Surface, Building
Material, Favorite, Layer, Pen, Story Plane and Zone Category.

Place ARCHICAD Nodes

The ARCHICAD (AC) nodes available on Grasshopper’s ARCHICAD tab work the same way as other
components or parameters in Grasshopper. Use the familiar methods to place them on the
Grasshopper canvas. After the required input parameters are received, a preview is immediately
visible in the Rhino window.

Grasshopper-ARCHICAD Live Connection 2.2 User Guide 13
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ARCHICAD Parameter Nodes

AC Parameter nodes refer to point coordinates or existing 2D or 3D
geometry in the ARCHICAD project. @O@QO

Most of the Parameter nodes represent special ARCHICAD data that can be ° @ 9 @ 0
interpreted only by other ARCHICAD components. However, data stored by O o O @

the AC Point, AC Spline and AC 2D Curve Parameter nodes can be converted

automatically by Grasshopper into native Point and Curve data. Therefore, D Q @ O
these three Parameter nodes are an integral part of the Grasshopper code.

AC Point Parameter Node

Like Grasshopper’s Point parameter, the ARCHICAD Point parameter :ﬁ)
(AC Point) can store 3D point data. This data is defined in ARCHICAD,

not in Rhino. The AC Point parameter can reference a single or multiple il | &
3D points. Preview
(] Enabled
Set One Point S o
L) Runtimewarnings b
1. In Grasshopper, right-click on the center of the AC Point. i Diply ’
2. Select ‘Set One Point in ARCHICAD’ from the context menu. (The Reverse
Rhino and GH windows close. In ARCHICAD, notice that the Status R
Bar displays the message: “Click a point”.) :_raftl_fy
impli

3. Click in the ARCHICAD window to define the origin of the AC Point. —
(If the point is selected successfully, the Rhino and GH windows S
appear again, and the parameter node turns from yellow to gray, to
indicate that it is not empty.)

Clear values

Internalise data

4. Now continue working as needed in ARCHICAD, or return to Extract parameter
Grasshopper. @ Hep..

Note: The value stored in the parameter node can be redefined at
any time using the “Set One Point” or “Set Multiple Points” commands.
Set Multiple Points

1. In Grasshopper, right-click on the center of the AC Point.
Select "Set Multiple Points in ARCHICAD from the context menu.

Click several times in the ARCHICAD window to define a collection of points.

R WN

Click ESC to exit input mode.

umn 'E. [ Geometry o Geometry t

{ Motion Transform

'm' (| Start Point / L
ine D
{ End Point
@ Point

Contains & collection of three-dimensional ARCHICAD point coordinates

One locally defined walue..
Point
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Note: The AC Point component converts the point defined in ARCHICAD into a Grasshopper
Point parameter. This AC Point parameter node can then be assigned to any GH component that
requires a GH Point-type input.

To define the origin of an AC Point, you can also click on any hotspot of a placed ARCHICAD element.
In this case, the AC Point will remain associated to its parent element in ARCHICAD.

For example:
1. In Grasshopper, place two AC Point parameter nodes.

2. To define their origins, go to ARCHICAD and click the endpoints of an already placed Beam
element.

3. In ARCHICAD, move the Beam to a new position.

4. Click the ‘Send Changes’ button on the Grasshopper Connection Palette: the coordinates stored
in the AC Point parameters are modified to match the Beam’s new position.

2D Curve and Spline Parameter Nodes

2D Curve Parameter node can reference one or more 2D elements drawn in ARCHICAD with the
Line, Polyline or Circle Tool, while the Spline Parameter node does the same for elements created
with the ARCHICAD Spline tool.

Note: You can use the 2D Curve or Spline Parameter node to reference any Polyline, Circle or
Spline element drawn in any 2D ARCHICAD Viewpoint (Floor Plan, Section, Elevation, etc.).
However, in Grasshopper, the new planar shape will always be drawn in the XY plane.

Referencing a polyline in ARCHICAD:
1. Draw a polyline in ARCHICAD with the Polyline Tool.
2. In Grasshopper, place an AC 2D Curve Parameter node and right-click on its center.

3. Select ‘Set One 2D Curve’ from the context menu. (The Rhino and GH windows close. In
ARCHICAD, notice that the Status Bar displays the message: “Click an element”.)

Note: If any ARCHICAD elements are selected at the time you issue the ‘Set One 2D Curve’
command, and if the set of selected elements includes one element drawn with the Polyline/
Line/Circle Tool, then the parameter is automatically defined according to the selected element,
and no further element selection is needed. If the selection does not include a Polyline/Line/
Circle element, or if there are multiple selected Polylines/Lines/Circles, then the program will
deselect the elements, and prompt you to select elements in ARCHICAD.

4. Click on the previously drawn polyline in the ARCHICAD window. The 2D Curve Parameter node
is now referencing the selected ARCHICAD element.

The 2D Curve and Spline parameter nodes remain associative to their parent element in ARCHICAD.
After editing the referenced element in ARCHICAD, press the ‘Send Changes’ button on the
Grasshopper Connection Palette to update the information stored in the 2D Curve or Spline
parameter node.

Note: The AC 2D Curve and Spline parameter nodes are compatible with the GH Curve
parameter. Thus, they can be used as the input for any GH component that accepts the GH curve
type as an input.
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ARCHICAD Nodes
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Naturally, you can use the 2D Curve or Spline Parameter nodes to reference multiple ARCHICAD
Polyline, Spline, Line or Circle elements. To do this, use the “Set Multiple 2D Curves” command from
the context menu.
Note: If any ARCHICAD elements are selected at the time you issue the “Set Multiple 2D Curves”
command, and if the set of selected elements includes at least one element drawn with the
Polyline, Circle or Line Tool, then the parameter is automatically defined according to the
selected element, and no further element selection is needed.

Fill, Roof, Slab Parameter Nodes

Data in Fill/Roof/Slab Parameter nodes cannot be converted to native Grasshopper data types. For
this reason, Grasshopper operations (such as the Move component) cannot be carried out on them.

However, data of the Fill/Roof/Slab Parameter nodes can be used by the Reshape and Deconstruct
components.

Polygon
Slab
5& Slab Settings t
Synchronize

Geometry ﬂ Geometry
Curve

Circle

Plane

Radius

To add or change data in a Parameter node: use the commands from the context menu (e.g. “Set
One Roof”/“Set Multiple Roofs”), as described for 2D parameter nodes, above.

Note: The Roof Parameter Node can reference only Single-Plane Roofs in ARCHICAD (that is,
simple roofs consisting of a single plane). Roofs created with the more complex, Multi-Plane
Geometry method are currently not handled.
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Wall Parameter Node

Data of the Wall Parameter node can be used by ARCHICAD Connection’s Deconstruct Wall
component and by the Door/Window-type Design components.

~, Curve
wall | é :
¥ Wall settings
[« Synchronize

q Wall

d h Insertion Point
D Door D

Orientation

[« Reveal Side

( Door Settings

To add or change data in a Parameter node: use the commands from the context menu (e.g. “Set
One Wall”/“Set Multiple Walls”), as described for 2D parameter nodes, above.

Other 3D Parameter Nodes

Data of other 3D Parameter nodes - Beam, Column, Curtain Wall, Door, Mesh, Morph, Object, Shell,
Window and Zone - can be used only by the corresponding Deconstruct components.

To add or change data in a Parameter node: use the commands from the context menu (e.g. “Set
One Beam”/“Set Multiple Beams”) as described for 2D parameter nodes, above.

Modify Information Stored by Parameter Nodes

The content of Parameter nodes in ARCHICAD can be redefined, deleted or updated at any time. To
redefine the stored value, use the “Set One Element” or “Set Multiple Elements” commands from
the context menu.

See description at AC Point Parameter Node.

e To clear the parameter values entirely, use the “Clear Values” command from the context menu.

Grasshopper n

@ Grasshopper.gh

¢ Information stored in a Parameter node is updated automatically if the
referenced element has been changed in ARCHICAD - provided that the “Send
Changes” button on ARCHICAD’s Grasshopper palette is activated. If “Send
Changes” is not active, then Grasshopper will not reflect the modifications to
referenced ARCHICAD elements. B

U, Unlock GH Elements

©. ¥ Break Connection
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The Synchronize Parameter

All AC components that generate ARCHICAD elements (Document and Design components) include

“Synchronize” as an input parameter. It is a Boolean type parameter which enables components to
communicate with ARCHICAD.

If a component’s Synchronize parameter is set to TRUE, changes made to that component will be
synchronized with ARCHICAD automatically.

If Synch is set to FALSE, the component will not generate any element, and will return a single “Null”
value, regardless of the number of input parameters.

| |

Synchronize @ Synchronize
Curve % Beam Synchronize with ARCHICAD
. TRUE =ct made to the will be synchronized with ARCHICAD automatically.
Beam Settings FALSE = the component does not communicate with ARCHICAD

One locally defined walue..
Trus

Note: Synchronization works only if ARCHICAD’s Grasshopper Connection is on: that is, the
green icon on the Grasshopper Connection Palette is spinning.

Tip: You can attach a single Boolean Toggle node to the Synchronize parameters of several
components (as shown in the illustration below). This way, you can control the Grasshopper-
based connection to entire parts of a building via a single toggle. Just switch the Boolean Toggle
to FALSE to turn off the synchronization function for those parts of the building that are not
being modified. As a result, working with Grasshopper-ARCHICAD Connection becomes more
efficient: only the affected parts of the model are recalculated.

Boolean Toggle

Synchronize

Panel
Ancher Point
) U Column D
End Point o
Column Settings
Synchronize
p {0}
C[ @ F Curve [j Wall ; 5
¢ Wall Settings
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ARCHICAD Document Components

Document components generate 2D documentation elements in ARCHICAD. There are

three Documentation components so far: the 2D Curve, the 2D Fill and the 2D Spline A r
component. All of them have two required input parameters: the Curve parameter 7 A
defines the shape of the newly created planar element, while the 2D Viewpoint

parameter determines the 2D Viewpoint (Section, Floor Plan etc.) of ARCHICAD onto R
which the new element will be placed.

Note: ARCHICAD’s documentation elements — such as those created by the Fill, Line, Circle,
Spline and Polyline tools — are not visible in 3D views, only in 2D views (Floor Plan, Section,
Elevation, Interior Elevation, etc.). Therefore, only 2D viewpoints can be used as the input
parameter for the 2D Curve and 2D Spline Components.

Choosing the Viewpoint:

1. Place a 2D Viewpoint Input Node, then connect it to the “2D Viewpoint” input parameter of the
2D Curve or Fill component.

2. Click on the right side of the 2D Viewpoint Input Node. A tree structure appears, corresponding
to the ARCHICAD project’s Project Map.

3. Choose the desired Viewpoint, then click Select.
See also 2D Viewpoint Input Node.

( Synchronize

Synchronize

Fill Settings (Ere R @ GEanEd
Curve

Note: The 2D Curve and Fill components will accept only curves lying on a single plane as inputs.
The input curves defined in Grasshopper can also be planar splines, but ARCHICAD will segment
these, creating segmented Polylines.

At present, it is not possible to attach additional GH components to the right side of Document
components (e.g., you cannot transform them with the Move component), because the data output
by the Document components are not recognized by the GH components. However, Fill-type data
created with the Fill component can be used as input by Reshape components (Add/Subtract
Polygon).
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2D Curve Component

This component generates curves (defined in Grasshopper) in a selected 2D Viewpoint of the
ARCHICAD project. The curves created in ARCHICAD will be Polylines. If you want to define the
ARCHICAD Layer, the Line Pen or Line Type of these Polylines, attach a Polyline Settings component
to the Settings input parameter of the 2D Curve Component.

Navigator - Project M... n

XN ey
4 (M Untitled "
a7 stories P—
Y 2. story ‘i; . ynchronize
[ 1. story . Curve
[5 0. Ground Floor
£ Sections
77 Elevations
[0E] interior Elevations
Waorksheets
(D petails o

< >

a 2D Curve

2D Viewpoint
Polyline Settings

2D Spline Component

This component works the same way as the 2D Curve Component, except that it generates Spline
elements in ARCHICAD. The Spline Settings component, in addition to Pen and Layer options,
includes two Boolean (TRUE/FALSE) options: you can choose to generate a normal vs. Bézier curve,
or Open vs. Closed-ended Spline.

Layer; 2D Drafting - General

Curve

/L spline

( 2D Viewpoint

Spline Settings
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2D Fill Component

The Fill component will create Fill elements (that is, 2D hatches) in ARCHICAD. Like the 2D Curve
component, the Fill component has two required input parameters: a Polygon (defined by a planar
closed Curve-type or planar Surface-type geometry) and a 2D Viewpoint.

Use the Fill Settings component to define the attributes of the generated element (use the Pen, Line
Type and Fill Pattern parameters), its Layer (use the Layer parameter), and/or to show its Area Text.

Plane
Radius

Segments
Fillet Radius

( Synchronize

Polygon

( 2D Viewpoint % <0l

. Fill Settings
Note: Right-click the Fill Settings component
to open the context menu, where you can
define the Fill category of the newly created
Fill element. If you choose “Cut — Building
Material”, then you can use the Building
Material parameter (instead of the Fill [ —
Pattern) to define the pattern of the Fill o
element to be created in ARCHICAD. | Gategony ot ARCHICAD i v |7, orting

@ Help.. = Cover
Cut
2D Text Component S| utuiing e |

Use this component to create Text in ARCHICAD. It has three required parameters: the text itself,
plus Insertion Point and 2D Viewpoint.

Synchronize
Text

Insertion Point A Text
2D Viewpaint
Text Settings.

4 Grasshopper
<@
i E 0. Ground Floor |

Grasshopper e —

Use Text Settings to control:
e Font Name (e.g. Calibri, Ariel) - use the Font Name parameter component
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e Font Size

Note: This value uses Rhino’s units. If Rhino is set to use meters, then font size is also set in
meters.

e Font Pen - use the Pen Parameter component

e Font Style (e.g. Plain, Bold, Italic, or a combination style) - use integer value
e Alignment (Left/Center/Right/Justified) - use integer value

e Leading - use number value

e Width Scale - use number value

e Spacing Scale - use number value

e layer

e Renovation Status
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ARCHICAD Design Components

The Design components generate native 3D elements in ARCHICAD 7 4 A
Their input parameters must be geometric information (point, curve, St E@‘ 28 G’L: 7 A8,

E@'.f%cﬁjaﬁi

h -

etc.) which define the new elements’ position. Most of them have a
single output parameter which stores geometric information.

The outputs of AC Design components currently cannot be used as
inputs for the transforming components in GH (such as Move). For some
components, however, the output data can be re-used as inputs for other AC elements (for

example, the Window component requires a Wall-type input; the Reshape components accept Fill,
Slab and Roof type inputs).

( Synchronize { Synchronize
Curve G Roof Single-plane Geometry ﬂ Geometry
( Roof Settings (¢ Curve

Synchranize q synchronize
Curve & > Slab wall
: 5 B Window
Slab Settings ( Horizontal Distance
¢ Window Settings
synchronize
synchronize
Curve D Wwall Y !
: Wwall
Wall Settings D Door
Horizontal Distance

Door Settings

Synchronize

Curve =3 Beam D

( Beam Settings

Important: If a Grasshopper component (e.g. Slab) is assigned multiple curves as input
parameters, then ARCHICAD will generate a corresponding number of Slabs, each of which is
separately editable in ARCHICAD.

To refine a Design component’s geometry or attributes, you can attach the corresponding Settings
component. By default, Settings parameters initially inherit the values set in ARCHICAD (in the Tool
Default Settings dialog of the corresponding tool). In Grasshopper, use familiar methods to override
these default values (e.g. attach a Number Slider component).

See ARCHICAD Settings Components for details.

Building Material

( Synchronize
Height Curve D Wwall
er Sli ©0.250 . Thickness ( Wall Settings

@ Qutside Slant Angle
[©] inside slant Angle.

[ﬂl'tg <& ARCHICAD Layer ]

q
(
(
|
d
(
(
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Note: Many ARCHICAD-based parameters of design elements are not yet available for
Grasshopper’s AC components. The value of these parameters, at the time the component is
first generated, will equal the current default value set for the corresponding tool in ARCHICAD.

Column Component

The AC Column component requires two points as input parameters. Based on these, Grasshopper
will generate ARCHICAD columns along the defined segments (which serve as the column axes).

Column (Locked)

Layer: Structural - Bearing
Story: 0. Ground Floor

Synchronize
Anchor Point

End Point U column. b

Column Settings

Connect a Column Settings component to the Column Settings input parameter to control the
Building Material, Layer and additional geometric parameters.

Through the context menu of the
Settings component, you can define the
column profile (Rectangular, Circular or
Complex Profile).

Notes:

— You can also attach an AC Point
parameter to an AC Column
component, because AC Point
data is compatible with GH Point
data.

ColumnSetR &5

Enabled
\;;5 Bake...

Structure of ARCHICAD Column 3 | Rectangular
— Defining the end point of the @ Hep. @ Circuter
Column is optional. If you leave it F ComplexProfil

undefined, you will get a straight
column with default height (the current height set in the Column Default Settings dialog in
ARCHICAD).
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Slab Component

The AC Slab component generates an ARCHICAD Slab element. The required input parameter is one
or more closed polygons defined by the planar surface of Curve type data. Because ARCHICAD can
interpret only horizontal slabs, the input polygons must be in the XY or parallel plane.

The input geometry may be:
e a Grasshopper Curve parameter referencing one or more selected closed curves in Rhino,

e a Grasshopper Surface parameter referencing one or more planar surfaces which may also have
holes in them,

e any closed planar Curve or planar Surface geometry generated by a Grasshopper Component,
® a 2D Curve parameter referencing a closed ARCHICAD polyline element.

( Synchronize
1| ( Polygon &> slab
( Slab Settings

Slab (Locked)

- Synchronize
ane
Polygon Polygon & > Slab
Radius @ S
ab Settings
Segments i g
Fillet Radius

Polygon & > Slab

0 Synchronize
( Slab Settings

Important: In Rhino, you can select a curved spline as the input parameter for the AC Slab
component, but the outline of the corresponding Slab generated in ARCHICAD will be
segmented.

Use the Slab Settings component to access additional parameters. Open its context menu to define
the Structure (Basic or Composite) of the generated Slab elements; the set of available input
parameters will change accordingly.
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Wall Component

The AC Wall component generates ARCHICAD Wall element(s), based on one or more lines,
polylines, or open or closed curves. The input geometries must be in the XY or a parallel plane.

d Synchronize
(@ > d curve [ wall D
q Wall Settings

q PointB o Plane

¥y

{ Synchronize

.0
Slant Angle 1: 50,00°
Slant Angle 2 130,00°
Thickness: 300

Height: Linked to 1. Story
Layer: Structural - Bearing
Story: 0. Ground Floor

{ Synchronize
.(E,- d Curve D Wall D
¢ Wall Settings

Important: If you select a Rhino spline as input curve parameter for the AC Wall component,
then the resulting element in ARCHICAD will not be a single curved Wall, but rather a chain of
Walls, whose segments correspond to the spline segmentation.

To access additional parameters — such as Layer, Height or Building Material — connect a Wall
Settings component to the Wall Settings parameter.

The Structure (Basic, Composite or
Complex Profile) and Geometry
Method (Straight or Trapezoid) of the
generated Wall elements can be set
through the Wall Settings component’s
context menu. Depending on these
Structure and Geometry Method
values, the rest of the available
parameters will vary.

WallSetB

Enabled

Bake...

Structure

-

Basic

Geometry Method of ARCHICAD Wall 3 JEI Composite
J& Complex Profile

Help...
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Beam Component

The AC Beam component generates ARCHICAD Beam element(s) along one or more lines, polylines,
or open or closed curves. These curves may be in 3D space.

q Synchronize
) 'm' ( Curve ™=y Beam ]
( Beam Settings
¥

Layer: Structural - Bearing
Stow; 0. Ground Floor

=

Important: 3D curves will be segmented in ARCHICAD. Therefore, the geometry generated by
the AC Beam component will produce not a single curved Beam, but rather a chain of beam
segments.

Attach a Beam Settings component and
open its context menu to decide what
kind of cross-section the generated
Beam elements should have
(Rectangular or Complex Profile).

Based on this choice, the Settings
component will contain further
parameters, such as Profile Rotation,
Axis Offset, and Building Material.

BeamSetP &

Enzbled

Bake...

Structure of ARCHICAD Beam 3 | Rectangular

Help. Complex Profile
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Morph Components

There are two kinds of Morph components:

The Morph Curve component transforms the Curve from Rhino into an ARCHICAD Morph curve.

The Morph Solid component transforms Mesh geometry from Rhino into a solid ARCHICAD
Morph.

Y cke:
N | Synchronize
Q |. | Curve (Tz Morph

 Morph Settings.

synchronize
Mesh Gé Morph

( Morph Settings

Brep . Ve Synchronize
Settings Mesh Morph

Settings

Wire Display b
Principal

Reverse

Flatten

Graft

Simplify

b Set Mesh Options

Manage MeshParameters collection

HPEOD@®

Clear values
Internalise data

Extract parameter

@ Hep.

With the help of the Morph Settings component, you can assign a Building Material to your newly
generated Morph element, and you can decide which ARCHICAD layer it should appear on.

Note: In Grasshopper, you can also use Box, Surface, or BREP-type values as Mesh inputs for a
Morph - since these values are converted into the Mesh type automatically. When using BREPs,
it is recommended to also use the “Mesh-Brep” converting component in GH, to help keep
polygon count under control.

Note: The Weld Edge information is stored in the Morph component. Thus, the Weld Edge
information applied to the input Mesh will also be applied to the Morph element generated in
ARCHICAD.
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Roof Component

The Roof component requires a planar polygon input geometry for generating an ARCHICAD Single-
plane Roof. This input polygon may be defined by a Curve-type or Surface-type data that can lie in
any plane, thus defining not only the Roof contour but also its pitch and elevation.

| Roof (Locked)

| Structure: Tile - Roof
| Piect Line Bevation: -330
| Rof Pitch: 24,44°

Thickness: 330

Lajer: Shell - Roof
Story: 0. Ground Floor |

You can determine the Structure type (Basic or Composite) of the element through the context
menu of an attached Roof Settings component. Depending on the selected Structure value, the
Settings node will include Composite or Building Material as an input parameter.

Note: The planar curve or surface used for the polygon input defines the 3D location and plane
of the Single-plane Roof element generated by the Roof component. Thus, the Offset from
Home Story and Roof Pitch parameter values (stored in the Favorites of the Roof Settings input)
has no effect.

FA Roof Selection Settings ? *

T Selected: 1 Editable: 1

hd QI GEOMETRY AND POSITIONING

B oSG

| 0. Ground Floor {Current) v|

Home Story:

. to Project Zero |k :
- & Y |s0.00°

» L5 MULTI-PLANE GEOMETRY

» =1 FLOOR PLAN AND SECTION

» {J» MODEL

» CLASSIFICATION AND PROPERTIES

<E> 5hell - Roof 3 Cancel
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Shell Components

The ARCHICAD Shell tool has three Geometry Methods - Revolved, Extruded, and Ruled. ARCHICAD
Connection provides a separate component for each. Each component has two required input

parameters, whose type is either Curve, Vector or Axis.
Synchranize
| comamian 254 P
g Shell Ext, Settings

Shell (Locked)

Structure: Generic Wall/Shell @Do@\;ﬂ Generic Wall/Shell D

Absolute ARitude: 0

Layer; Shell - General
Story: 0. Ground Floor

o q Synchronize
‘m. q First Profile Curve
A shell
( Second Profile Curve
ll ( Shell Ruled Settings
Plane
Radius Synchronize
Profile Curve
( Segments @ {ﬁ) Shell

Revolution Axis

q Fillet Radius

Shell Rev. Settings

Each of the three Geometry Methods has its own Settings component. Use the Settings component
context menu to define the generated element’s structure: Basic or Composite. In addition, you can
use the Settings parameters to fine-tune the Shell geometry or define its Building Material/
Composite attribute.
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Mesh Component
This component generates an ARCHICAD Mesh element based on the 3D coordinate set it receives
as input. The input must consist of a set of at least three points.

Use the Mesh Settings component to define Building Material, Height, and Layer. Use the Structure
input to set the Mesh display as either Solid or Surface only.

synchronize
d Points

) '% Mesh
( Mesh Settings

Boundary

Grasshopper-ARCHICAD Live Connection 2.2 User Guide 31



ARCHICAD Nodes

Curtain Wall Components

To generate a Curtain Wall element from Grasshopper, use the following four components:

Curtain Wall Component

Generates a Curtain Wall by extruding the reference line (defined by the Curve input). The extrusion
is perpendicular to the plane of the Curve input. The height of the generated Curtain Wall is defined
in the Domain input, and its External Side is defined by the point-input value of the same name.

Curtain Wall

Layer: Finish - Wall
Base Hevation: -3000
Nom inal Thickness: 300
Story: 0. Ground Floor

( Synchronize

Curve

Domain LIHI Curtain Wall

Note: Use the Construct Domain Grasshopper component to define the Domain input
parameter. If the Domain Start parameter value is negative, then the extrusion will extend
below the reference line (in the negative Z direction).

— Example: If the Domain value is “-2 to 3”, then the generated Curtain Wall will be 5 meters in
height, and will begin at a point two meters below the reference line.

Curtain Wall Segment Component

Works similarly to the Curtain Wall component, but here you can only create a single Curtain Wall
segment (its input reference line is a Line, rather than a Curve). The component also requires a
Plane Point input parameter. The extrusion is perpendicular to the reference plane defined by the
Line and Plane Point inputs. The Plane Point also defines the Curtain Wall External Side.

Line input: reference line of Curtain Wall

Plane Point input: point defining
(together with the reference line)
the reference plane of the extrusion.

Reference plane (the extrusion takes
place along the normal of this plane)

XY plane
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Synchronize
Line
Plane Point
|| i Curtain Wall D
Domain “—
Flip CW
CW Settings

\
\

Curtain Wall Boundary Component

Generates a Curtain Wall element with a Boundary of a freely defined shape. The plane and shape
are defined by the closed polygon given as the Boundary input parameter. Here, too, an input point
defines the External Side.

Synchronize

Boundary .
i E@ Curtain Wall
External Side

CW Settings

Curtain Wall Boundary Custom Component

A modified version of the CW Boundary component; use it to create a Curtain Wall with a custom
pattern. The custom pattern is defined using a set of lines created in either Rhino or Grasshopper.

d Plane

d Radius
s
( Fillet Radius

Synchronize
Boundary
External Side:
CW Settings
( Custom Frame Axes
Panel Points EI:I% Curtain Wall fy
Frame Settings
Panel Settings
( Custom Frame Class
q Boundary Frame Class
Panel Class

The component’s top four input parameters are the same as those of the regular Curtain Wall
Boundary component. However, there is an important difference: in the Boundary Custom
Component, if you assign CW Settings input parameters (by attaching a CW Settings node or Input
node), these will not affect the Curtain Wall Scheme Settings (a pop-up note will alert you of this).
The reason: the Boundary Custom component ignores the Grid pattern defined in Scheme Settings,
and instead uses an empty Boundary Frame as the starting point. This is the “blank slate” on which
the custom pattern is created. Apart from Scheme Settings, all other CW Settings values (e.g. Layer,
Home Story, properties) will have the expected effect in the Boundary Custom component.
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Custom Frame Inputs

X2 Plane Plane

Radius

Origin o}

Synchronize

Segments @ Boundary
Fillet Radius External Side
CW Settings

Custom Frame Axes

Panel Points E‘Ef'l Curtain Wall [

Frame Settings .

Panel Settings

Boundary Frame Class
Panel Class

PN S S S

e Custom Frame Axes: Expects a set of lines. Each line defines the length of the custom frame's
axis. Each line must lie in the plane of the Boundary Frame, and all of its points must line within
the Boundary.

— Tip: As needed, use the Trim with Region component from Grasshopper to achieve this.

e Frame Settings: A special parameter with data type of “CW Frame Settings”. Defines the Frame
types (Frame Class) used to construct the Curtain Wall generated by the component. Add new
items by using the CW Frame Settings Node or Favorite Input Node. Based on the Classes
defined in Frame Settings, you can then input a Custom Frame Class or Boundary Frame Class for
any Curtain Wall Frame.

If you do not assign input values to the Frame Settings parameter, then the CW will be generated
in ARCHICAD using only the four “built in” Frame Classes: Corner, Boundary, Division or None.
These classes will be used depending on the value set for the Custom Frame Class and Boundary
Frame Class input parameters (hover over the input parameter to see the available values). If
you do assign input values to the Frame Settings parameter (e.g. via CW Frame Favorite), this
expands the set of available inputs for the Custom Frame Class and Boundary Frame Class
parameters.

e Custom Frame Class: Expects a set of integers. These inputs define the geometry of the Custom
Frames: each integer represents a Frame Class. (Hover over the input parameter to see the
available values.) The Corner, Boundary, Division and None classes are always available, plus any
additional values corresponding to Frame Classes added via the Frame Settings parameter.

e Boundary Frame Class: Expects a single integer parameter. This defines the geometry of the
Boundary Frame (which is uniform along its entire length). Hover over the input parameter to
see the available inputs for this parameter.
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Custom Panel Inputs

Origin [-_-’I‘Z Plane Plane

Synchronize
Boundary

External Side

CW Settings
Custom Frame Axes

E:T'f Curtain Wall

Frame Settings

Panel Settings

Custom Frame Class
Boundary Frame Class

Panel Class

Radius
Segments
Fillet Radius

P

Panel Points: Use this parameter to define the type (Panel Class) of each Panel created within
the custom Frames.

This input parameter expects a list of points. Each point is assigned a Panel Class (this
assignment takes place via the Panel Class input parameter).

Grasshopper assigns Panel Class to each Panel Point as follows: in each Panel, it locates the point
nearest to its center of gravity, then assigns the Class of that point to the Panel.

If the component’s “Check Panel Region” option (available in the context menu) is OFF, then a
Panel Class is assigned even if the nearest point falls outside of the Panel boundary. If the option
is ON, then a Panel Class is assigned only if the Panel contains at least one point within its
boundary. All other Panels keep their default “Deleted” status.

Panel Settings: A special parameter with data type of “CW Panel Settings”. Defines the Panel
types (Panel Classes) used to construct the Curtain Wall generated by the component. Add new
Panel Classes by using the CW Panel Settings Node or Favorite Input Node. Use the Panel Classes
defined here as inputs for the Panel Class input parameter.

If you do not assign input values to the Panel Settings parameter, then all panels of the
generated Curtain Wall will retain their default “Deleted” status - that is, empty.

Panel Class: Expects a set of integers, which indirectly define the properties of the Curtain Wall
Panels.

Each integer represents a Panel Class assignment for each Panel Point. (Points are defined in the
Panel Points parameter; the set of available Classes is defined in the Panel Settings input). Hover
to see the set of available values in the tooltip. The default “Deleted” status, which results in an
empty panel, is always available. The other available values depend on the set of Panel Classes
as defined in Panel Settings.

Settings Components for Curtain Wall

The CW Settings component can be attached to any of the four CW components.

See CW Settings Component.
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( Synchronize

Bound
il @ Curtain Wall
d External side

 CW Settings

Further Settings components can be attached as needed:
e Use the CW Scheme Settings component to define the pattern of the Curtain Wall Element.
See CW Scheme Settings Component.

Note: As mentioned, the CW Scheme Settings input does not affect the CW Boundary Custom
component, which always uses an empty pattern as a starting point for the custom pattern
(consisting of a Boundary Frame only, without any grid lines or panels).

e Use the CW Frame Settings component to set up the Frame types available for the CW Scheme:
define Frame Classes to be used as Frame Class input parameters, thus defining the properties
of the Frames in the CW Scheme.

See CW Frame Settings Component.

e Use the CW Panel Settings component to set up the Panel types available for the CW Scheme:
define Panel Classes to be used as Panel Class input parameters, thus defining the properties of
the Panels in the CW Scheme.

See CW Panel Settings Component.

For a step-by-step example, see:

Example 3: Use Rhino to Create a Custom Curtain Wall
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Zone Component

The Zone Component generates spatial units in your project, to represent rooms, wings of a
building, blocks of a housing estate, or functional areas. ARCHICAD Zones in 3D can also be used for
simple mass modeling; and they also form the basis of the Model Review process in the Energy

Evaluation function.

A Zone Component requires two inputs: the Curve input determines the Zone’s shape, while the

Stamp Position defines the location of the Zone Stamp.

The content of the Zone Stamp can be defined using the Zone Settings component. Connect
additional inputs to Zone Settings to assign metadata and attributes.

See the sections on The Property Settings Component (Controlling Metadata) and the Zone Category

Input Node.

&

{ Vertices
Polyline D
( Closed F Y

and Recreationhed

=

I

(RS Ny

d synchronize
d Curve
" [2Y zone D
( Stamp Position
( Zone Settings

Generic
GROSS AREA
Residential and Recreation

Production & Research
Storage & Sales
Education & Cuture
Medical Treatment

Other Usage

Technical Equipment
Commurnication & Access

S

Note: By default, Zones in ARCHICAD are visible only on the Floor Plan. To see them in the 3D
window, go to View > Elements in 3D View > Filter and Cut Elements in 3D, and check the Zone

item under “Element Types to Show in 3D”.
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[ Filter and Cut Elements in 3D ?
Stories to Show in 3D
(® Infinite
() Limited: To | 2. story
From | 0. Ground Floor

Trim Elements to Story range

Marquee Effect

Show Elements: @ Inside Marquee
() Outside Marquee

[#] Trim Elements to Marquee

Cut Surface Display
@ Use Element Attributes

O Custom U 98 |
B B eaint - Ui, »

Element Types to Show in 30

F  window 2
B Door

= Skylight

Br Object

G Lamp

= slab

<& Mesh

A Roof

wl  shel

Ef curtain wall

2 zone % E

(I} Marph

. starr

#  Railing

W

e

Object Component

AC Object components require a single input parameter: anchor point. The default Library Part type
depends on what is set in Object Default Settings. To place a different object, attach an Object
Settings component, and use “Select ARCHICAD Library Part” from the context menu. This
command is available only if you have activated the “Use existing Library Part” option in the same
context menu, as shown here:

Object (Locked)

Mame Armchair 0120
Base Hevation: 0

Layer: Interior - Furniture
Story: 0. Ground Floor

Synchronize
Anchor Point ﬁa Object
| Object Settings

ObjSet Existing

Enabled

| &

o=

Bake...

Create new Library Part

Use existing Library Part

Ble®

Select ARCHICAD Library Part

©

Help...

See also The Object Settings Component (Selecting or Creating Library Parts).
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To allow Grasshopper to access the Library Part’s internal parameters, you must modify its program
code.

Note: Library Parts are programmed using a code called “GDL” (Geometric Description
Language.) For details, see https.//en.wikipedia.org/wiki/Geometric_Description_Language.

Window and Door Components
Door/Window elements in ARCHICAD can only be placed into existing Walls — they cannot “float”
independently of a Wall. Thus, Door and Window components require a Wall-type input.

To create the Door/Window opening, the input data must include information on its location
relative to the host Wall’s reference line. You can define this in two ways: via distance or a point.

e The Horizontal Distance component defines the distance between the Door/Window insertion
point and the Wall's endpoint, along the Wall reference line.

e The Door/Window Point component defines the location of the Door/Window opening as a
point projected perpendicularly onto the Wall reference line.

| Window (Locked) |
Name, Window 20
W/H: 800 / 1500

Sillto Story 0: 1000 . 1 Synchronlze
Story: 0. Ground Floor | || .
( Wall Settings

Synchronize

Wall

E Window

( Horizontal Distance

Window Settings

As described for the Object component, attach a Door/Window Settings component, then open the
Select ARCHICAD Library Part dialog to choose an opening.

Note: Doors and Windows, like Objects, are Library Parts programmed in GDL (see above). For
more information, see Accessing GDL Parameters of ARCHICAD Library Parts.
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ARCHICAD Deconstruct Components

Use the Deconstruct components to extract information from existing
ARCHICAD elements: their reference geometry which determines their ‘ L_’;: ”.g_' 115% '9: | gl;
position, and their Settings. 7 A A [
Deconstruct components are the inverse of the element-generating %R | I% [g _' _9: %:
(Document and Design) components: output parameters of Deconstruct % LV <& |-l‘5§:
components are the same as the input parameters of the element- : ~ 9: ! "&9:
generating components. (The Synchronize parameter, which enables or
disables synchronization between Grasshopper and ARCHICAD, is an

exception: this parameter is missing from Deconstruct components.)

While Deconstruct components can be applied to data generated by the Design and Document
components, they also work on manually placed ARCHICAD elements. To refer to a placed
ARCHICAD element: right-click on the input parameter or corresponding Parameter node to open
the context menu, then choose the “Set one Element/Set Multiple Elements in ARCHICAD”
command.

Note: The Deconstruct Roof component can reference only Single-Plane Roofs in ARCHICAD
(that is, simple roofs consisting of a single plane). Roofs created with the more complex, Multi-
Plane Geometry method are currently not handled.

Enabled
Bake...

4

Wire Display 3
Disconnect 3
Reverse

Flatten

Graft

Sirmplify

HEEE

Set one Slab in ARCHICAD
Set Multiple Slab in ARCHICAD

Clear values
Internalise data

Extract parameter

‘_) Help...

If the referred element is modified in ARCHICAD, click “Send Changes” on ARCHICAD’s Grasshopper
palette to update the GH code.

To access detailed information on the settings of the input element, go to the Deconstruct
Component’s Settings output node, and attach the Extract Settings component to it.

See ARCHICAD Extract Settings Components, below.
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Use Deconstruct Component to Extract Brep Data

This function is available for the following ARCHICAD elements: Beam, Column, Slab, Wall, Mesh,
Zone, Shell, Single-Plane Roof.

The Deconstruct components for these elements now include a Brep output, which contains a list of
all of the element’s surfaces.

Wall Deconstruct Component, with Brep Output

It is also possible to extract a specific surface. From the context menu, choose “Select (Element)
Surface Type”, shown here for a Wall:

Deconstruct Wal

[ Enabled
& Bake..

| [ sdeavoisutaceType 1|

© Hep..

From the appearing list, choose the surfaces you need, then click select: the surfaces are now added

to the node:

Select ARCHICAD Wall Surface Type

Side Surface Wall Opening Refere ich

Surface

gRm

Reference Side Surfaces
—_—_——— Cut/ Crop / CSGSurface e OPTOSTE ST
S — [ Side Sufaces
| < [ Crop Upwards Surfaces
| [ i [ Crop Downwards Surfaces
IRE R B W [ Cut Suffaces
| . [ [] CSG Sufaces
Q ‘ | Reference Opposite [] Wall Opening Reference Side Surface
of ; Side Surface = -
.

Wall Opening
Side Surface
Wall Opening
ReferenceOpposite
Side Surface

Reference Side

= e o
[ Wall Opening Side Surfaces
Sudace O R ST

Wall Opening Replacement Surface

Note: You can attach a Brep node to these outputs, thereby accessing any of the surfaces for
further use in Grasshopper.
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An ARCHICAD Wall’s Specified, Highlighted Surfaces

Grasshopper-ARCHICAD Live Connection 2.2 User Guide 42



ARCHICAD Nodes

ARCHICAD Settings Components

Use the Settings component to define the parameters and attributes of the new ARCHICAD element
generated by a Document or Design Component.

Each Document and Design Component includes a Settings
parameter. Two types of components can be attached to it:

e Favorite Input Node: Use this if you want to control all of the new
element’s parameters from Grasshopper (see Input Node for more

information).

e Element Settings Component: Use this if you want to control only

certain of the new element’s parameters from Grasshopper.
Attach the corresponding element Settings component (Wall
Settings, Slab Settings, etc.) to the Settings parameter.

A0 A0 A0 &30 A0 00
S H S X

A0 A0 L0 LO00 L0 00

0

A

]

A0 &0 A0

0 &30 400 400

SYRV .
A0 A0
= |

A0 &0 A0

MK CP B

Using the Element Settings component is not mandatory. If you do not use it, then the newly
generated element will use the current Default Settings of its corresponding tool in ARCHICAD.

The right side of the Settings component has a single output parameter, which transfers the input
data to the Design or Document component.

In many Settings components, you can change the structure or type of the generated element,
using a context menu command. As a result, the set of input parameters available to the Settings
Node will change (that is, new parameters will appear on the left side of the node, and others are

removed).

Any upstream nodes that were formerly connected to a removed parameter will be disconnected.
Disconnecting nodes is not undoable. Therefore, the program displays a warning when you issue a
command that will remove an input parameter. To avoid disconnecting nodes, you can press Cancel.

Building Material
Height

Number Slider ©00.250 Thickness
E] Outside Slant Angle
E] Inside Slant Angle
Layer

o]

Structural Function

Position
Renovation Status

Property Settings

DD Wall Settings

1]

@

[WallSetB &

Enabled

Bake..

Structure 3

Geometry Method of ARCHICAD Wall »

Help..

Basic

B Complex Profile
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The Object Settings Component
(Selecting or Creating Library Parts)

Like other Settings components, the purpose of Object Settings is to define the ARCHICAD elements
generated by Grasshopper.

The Object Settings component lets you define the Library Part in two ways, from the context
menu:

e Use existing Library Part - Choose an existing Library Part from the ARCHICAD project

e Create a new Library Part, whose geometry is defined in Grasshopper.

Use Existing Library Part

First activate this option in the context menu (as shown below).

The Select ARCHICAD Library Part command is now available: click it to bring up a dialog. On the
left side, choose an existing Library Part. On the right side, the selected object’s internal parameters
are displayed for your information.

Synchronize

Anchor Point H>| Object

ObjSet Existing

Enabled

Bake...

Create new Library Part

Use existing Library Part

Ble € ®

Select ARCHICAD Library Part

®

Help...

On the left side of the appearing dialog box, choose among the ARCHICAD project’s loaded library
parts. On the right side, the selected object’s internal parameters are displayed for your
information.

Note: By default, Grasshopper cannot access the internal parameters of ARCHICAD Library Parts
- they are grayed out on the interface. To allow Grasshopper to access the Library Part’s internal
parameters, you must modify its program code.

See Accessing GDL Parameters of ARCHICAD Library Parts.
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Create New Library Part

This option lets you create a new Library Part, which will be placed in the Embedded Library of the
connected ARCHICAD project.

With this option activated, two additional input parameters appear on the left side of the Object
Component: Geometry and Object Name.

I/ Object Default Settings ? X
.
R C] E—
v ] Embedded Library ” ~ DI PREVIEW AND POSITIONING
~ B Grasshopper —=
] a08c820f-7a82-4553-b8e5-2983cdc018dS .- = /

 [i] Linked Libraries
~ ] ARCHICAD Library 21
~ [ 1. BASIC LIBRARY 21

4 |
s |
£ A
] 1
to Project Zero [¥
« B 1.7 Fumnishing 21 v . J
VR \
Hﬁ Relative [¥
\ﬁé 315,00° O @|s

» RHINO IMPORT OBJECT SETTINGS
+ [Z FLOOR PLAN AND SECTION

+ (3] mopeL

» CLASSIFICATION AND PROPERTIES

s <> Interior - Furniture ’ Cancel

y

{  Synchronize Home Story:

( Anchor Point E’“ Cbject D
 Cbject Settings

0. Ground Floor (Current) ~

©Hebn o

freeform shape|

Use the Geometry parameter to input the shape of the new Library Part.

Note: You can add multiple shapes as input Geometry. Grasshopper handles all the inputs as a
list, and uses them to generate a single complex Library Part. Whenever this Geometry data is
modified in Grasshopper, the resulting Library Part is modified accordingly.

You can use the newly created Library Part immediately: as an input parameter for the Object
generating component (in Grasshopper), or place it in the ARCHICAD project with the Object tool.

If you delete the Object Settings component in Grasshopper, the created Library Part will also be
deleted from ARCHICAD’s Embedded Library.

The same happens if you switch the Object Settings component to “Use existing Library Part”: the
generated Library Part is deleted from the Embedded Library, and any placed instances will be
missing Objects in ARCHICAD.
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The Property Settings Component
(Controlling Metadata)

The Property Settings component provides access to the metadata (e.g. Properties and
Classifications) defined for ARCHICAD elements. With this component, it is possible to assign
Element Classification to ARCHICAD elements or overwrite their Property values in Grasshopper.

Note: Use ARCHICAD Properties to add optional descriptive data to a building element. In
ARCHICAD, you can list and manage Properties in the Interactive Schedule, display them in
Labels, Zone Stamps, Door/Window Markers, import and export them among applications or to
spreadsheets. Use the Property Manager (Options > Property Manager) to create and delete
properties and customize their availability. Each element’s Properties are shown in the
Classifications and Properties panel of Element Settings. Classification is also used to map
Properties when exporting to IFC. ARCHICAD supports any number of national or company
standard classification systems at the same time.

[ Wall Selection Settings ? a Property Manager ?

W Selected: 1 Editable: 1 T Editable: 0
Q| wal v —

~ O GEOMETRY AND POSITIONING. Name Type Default
~ GENERAL RATINGS. +

psalion; 25 minutes ~ DEFINITION

1. Story (Home + 1) v AR & Fals
Undefined Galalivue
Generic Wall/shell »
[0 [ senericwaisshe # Sound Tran: neral 25
Preview/Default:
~ MAIN CONSTRUCTION +
So00 = w00 # Construction Type Option Set Undefined B
[0 i1z n 50,00
Home Story
0. Ground Floor (Current] v
to Project Zera ¥ | Reference line » AVAILABILITY
; = +
d e | 59 =+ o

+ [Az FLOORPLAN AND SECTION
» (& moDEL
- CLASSIFICATION AND PROPERTIES

CLASSIFICATIONS
[] Show conflicts with Properties in Hotlinks

New, Delete N Cancel

ARCHICAD Classification ... Wall

- 1D AND CATEGORIES ~
] SW-003
Strugural Function uUndefined
Pasition Undefined

- RENOVATION
Rengvation Status Existing &=
Show On Renovation Filter All Relevant Filters

- GENERAL RATINGS

@ Fire Resistance Rating 20 minutes
@ Combustivle False

Thermal Transmittance  Undefined

© Structural - Bearing y =

When first placed, the Property Settings components has no parameters. To assign Classifications
and select Properties, use “Select Classifications and Properties” from the component’s context
menu. In the appearing dialog, first choose one or more Element Classifications: this will determine
which Properties can be assigned to the generated element.

Once the Element Classifications are defined, the dialog lists only those Properties that are available
for assignment. Check the box of the Properties you wish to assign, then click OK.

The selected Properties now appear as new input parameters on the left side of the Property
Settings node.
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P8y

Enabled
Bake...

Select Classifications and Properties

Help..

Select Classifications and Properties n

Set Element Classfication
ARCHICAD Classfication - 21 Consiruction Elemert:
Q|
=) Construction Element ~
Beam
Search Propetties
Q, Covering
‘ Curtain Wall
Hame Type 2 Focting
GENERAL RATINGS L’:IZ‘""E'
Fire Resistance Rating Option Set Plate
[ Combustible True/False Raiing
[] Themnal Transmittance General Ramp
[] Seund Transmission Class General Roof
MAIN CONSTRUCTION ;’:b"
[] Construction Type Option Set Stair
Technology Option Set Wal
(] Goncrete Cover at Main Bars General -Opening
[] Class of Surface Option Set - Massing
[ uting wieighu General + Blement Comparert
Reinforcing Bement
ENVIRONMENTAL Furishing "
[] Life Cycle Environmental Integer
] Environmental Class Integer Select
[] Servics Lfie Integer v |
[ cance |

Elements generated by Grasshopper are automatically given the “Grasshopper Connection”
classification, which contains the “Grasshopper” Property group. This consists of two properties
describing the elements’ source data: a timestamp (the last time the element was refreshed
according to its source code) and the name of the Grasshopper source file (Grasshopper Source

Definition).

Object Selection Settings

» CHAIR SETTINGS

» I

]
ﬁ Q | | Armchair 01 21 Selected: 1
4[] Linked Libraries ~ ~ [ PREVIEW AND POSITIONING
4 [ ARCHICAD Library 21 =
.- 0o (|20 x520
4 £ 1. BASIC LIBRARY 21
e ol * ®
4 [ 1.1 Furnishing 21 e
D Appliances 21 | 0. Ground Floor [(Current) v|
D Bathroom Accessories 21 H
to Project Zero *
) Beds 21 . 1 L ®
|L| Cabinets and Shelves 21 A
" 520 -
— o~ | Ea]
. [
] k E
- [ )
i Relative [¥]
4 1o | oo |
| — B B (oo

Armchair 01 21

=

Armchair 03 21

:

Bar 5tool 21

Jl

Armchair 02 21
» [ MoDEL

» [Z FLOOR PLAN AND SECTION

hd CLASSIFICATION AND PROPERTIES

CLASSIFICATIONS
ARCHICAD Classification

... Furniture

Grasshopper Connection.., Grasshopper Element

Armchair 04 21 & Service Life o ~
= _Stored Eneray Undsfined
= GRASSHOPPER
=t Grasshopper Source Defi... NO_DOCUMENT_SELECTED
S5 Last Updated by Grassho... 2017.02.23, 17:35:06
= IFC PROPERTIES
IFC Type IfcFurnishingElement
ARCHICAD IFC 1D 306iSTFIP3SBNPhPKALDTX
v

lebzllA Db el

Bean Bag 21 w

AMEICTFIDICARDR DL AL hfu

| <B> Interior - Furniture

’| Cancel

OK
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Note: Classifications are assigned to elements only if the name of its parent Classification
System name is checked. An element can be assigned Classifications from multiple Systems, but
only one Classification per System. Properties listed below are those of the checked
Classification Systems.

Each ARCHICAD Property has one of the following Data Types:

e String: Simple text; corresponds to Grasshopper Text

Integer: A whole number; corresponds to Grasshopper Integer

Number: Any real number; corresponds to Grasshopper Number

Length, Area, Volume, or Angle

True/False: Logical value; corresponds to Grasshopper’s Boolean

Tags List: A series of words or phrases; used to make it easier to search for elements that use
such tags. In Grasshopper, this is achieved by assigning a series of Texts separated by semi-
colons.

Option Set: A list of text values. The user can choose one or more of these defined options
(multi-choice). In Grasshopper, this is achieved by entering the number of the option(s) to be
assigned to the Property, based on the info shown in the tool tip.

i
40 Property Settings
wEa | | * Property Name: EERE Fire Resistance Rating & . .
[Fire Resistance Rating | Element Classification
MName Type Default o Fire Resistance Rating

~ GENERAL RATINGS + A Description: Fire Rating

Fire Resistance R... Option Set <Undefined> minutes ‘

% Combustible True/False <Undefined=>

% Thermal Transmit... String <Undefined=>
% Sound Transmiss... String <Undefined=> ~ VALUE DEFINITION

~ PRODUCT INFO +
T ) Data Type: Opticn et v
3 Model string <Undefined>
s SerialNo. string <Undefineds Default Value: Options Setup...
s Barcode string <Undefined> ® Undefined
$ Acquisition Date  String <Undefineds> Ovalue Y
s PurchasePrice  Number <Undefined>
Expression Value

~ MANUFACTURING +

& 25 minutes
$ Manufacturer  String <Undefined> Sequence & 25 minutes
$ Production Date  String <Undefined> & 30 minutes
K e & 1 hour
s Country of Origin String <Undefined>

& 1.5hours
$ Product Website  String wrw.graphisoft... hour
. ) £ 3hours
s Point of Contact  String <Undefined>
% Warmanty End D... String <Undefined> # Undefined
™ MAIN CONSTRUCTION + Add Remove Edit..
2 Canctrution Tms Ontinn Set <llndsfinar> v
sh flicts with Properties in Hotlink ’

[ Show conflicts with Properties in Hotlinks AVAILABILITY FOR CLASSIFICATIONS o I P —
Mew... - Delete @ B &

Note: Whether an Option Set is multi-choice or single-choice is defined by the user in
ARCHICAD, using the Data Type - Option Setup choices at Options > Property Manager.

If the Option Set is multi-choice, then the Property Settings component in Grasshopper will
expect multiple inputs in the form of “Integer as List”. (If you input multiple integers here, then
multiple values are assigned to the Property, and the Property Settings component generates
one output). If the Option Set is single-choice, then the Property Settings component generates
a separate output for each input Integer.

Note: It is not possible to create a new ARCHICAD Property in Grasshopper; you can only assign
values to existing Properties. If you need a new Property, you can create it from ARCHICAD’s
Options > Property Manager dialog. Grasshopper is immediately updated with this new
information: the next time you open the Select ARCHICAD Property dialog, the newly created
Property will be listed.
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The Property Settings component’s first output parameter is “Property Settings” type. You can use
this as an input for the Settings nodes of 3D elements.

The second output parameter is “Element Classification”. Use it to add a Panel node, so you can see
the name of the Element Classification chosen in the Property Settings component.

( Wall Settings
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Curtain Wall Settings Components

In ARCHICAD, the Curtain Wall is a hierarchical tool. Thus, Grasshopper uses several interrelated
Settings components to define the Curtain Wall element. Each level of the hierarchy has its own

Settings component and its own set of Favorites (see Favorite Input Node).

B Curtain Wall Default Settings

T

~ FH curtain wall System
[Q Scheme
O rrames
M Fanels
X Junctions

= Accessories

= FJ_I GEOMETRY AND POSITIONING

BT e 52 300
f=3 Aot
Home Stdne CW CW
FRAME SCHEME
SETTINGS SETTINGS
+ [7 "LOOR PLAN AND SECTION
’ 'FU s evant Stories =
Fi PANEL ected with Over... ]
o SETTINGS [ .. o
o

TT # Frame Cut Lines Solid Line
= S MEMBER PLACEMENT

Place Junctions: Place Boundary Frames:

| O Inside Boundary
@ Center on Boundary
| O Outside Boundary

4% (O atall Grid Points

¥

k!. (®) One by one

Relation To Zones: Zone Boundary

L3 El CLASSIFICATION AND PROPERTIES

2} < Finish - Wall L4 Cancel [ ok

cw
SETTINGS

CURTAIN
WALL

i

To create a Curtain Wall via Grasshopper, use the Curtain Wall generating components (see Curtain
Wall Components). Using the CW Settings nodes is optional - for example, to use different settings

than the default ARCHICAD ones, or to control the Curtain Wall’s subelements using algorithms.

CW Settings Component

Contains Settings applied to the Curtain Wall as a whole. (They correspond to the topmost level of
the left-side tree hierarchy in ARCHICAD’s Curtain Wall Settings dialog.) At the bottom of the
component’s parameter list, you will find the same general input parameters as in other Settings
components: Layer, Home Story, Property Mapping, etc. At the top of the list are three specific CW

Settings:

Grasshopper-ARCHICAD Live Connection 2.2 User Guide

50



ARCHICAD Nodes

[ curtain Wall Default Settings 2 x

ﬁ k( Default
v [ curtain Wall system ~ DI GEOMETRY AND POSITIONING
[ scheme
Nominal w
O Frames T e Thickness #5300
I Panets -
— ® fo
s 0 A
3% Junctions /

2 Accessories Home Story: Reference Line:

N/A

o 10 Project Zero * to Panel Center *
— [, - =5 250

= [2 FLOOR PLAN AND SECTION

- FLOOR PLAN DISPLAY lo; m_u
=

Show on Stories All Relevant Staries

{ Synchronize
Curve

. . il:_ Domain E:q Curtain Wall
Floor Plan Display Projected with Over... 5¢ i}
Projection Mode Hybrid Figh \ ( External Side
Show Projection To Floor Plan Range ( CW Sattings
= CUT ELEMENTS.
Override Frame Type's Attrib. [m}

TC ./ Frame Cut Lines Sold Line

- 5 MEMBER PLACEMENT

Place Junctions: Place Boundary Frames:
IEE Oavall Grid points O Inside Boundary
e

#ti @onebyone ®) center on Boundary

|l O outside Boundary
Relation To Zones Zone Boundary

+ [E] CLASSIFICATION AND PROPERTIES
&5 < Finish - Wall 3 Cancel
Thickness

The Curtain Wall’s nominal thickness; this value is used by elements connected to the Curtain Wall
(e.g. connecting Walls).

Refline Offset

The Curtain Wall’s vertical offset from its Reference Line.

Scheme Settings Parameter

A special parameter with data type of “Scheme Settings”; it defines the Curtain Wall’s grid pattern:
the pattern of Frames, and thereby the geometry of the Panels. Scheme Settings also assigns Frame
and Panel Classes to these subelements, thus defining their appearance. Use the Scheme Settings
component or Favorite Input node to assign these values.

Note: CW Scheme Settings does not affect the CW Boundary Custom component, which
generates a custom pattern rather than the pattern defined in Scheme Settings.

CW Scheme Settings Component

The Curtain Wall Scheme is a unit pattern, which is repeated over the length and height of the
ARCHICAD Curtain Wall to fill out the surface with Frames and Panels. Thus, this component defines
the Curtain Wall pattern and the Frame and Panel types.

Use this component to control the parameters found on the Scheme Settings page of ARCHICAD’s
Curtain Wall Settings.

Grasshopper-ARCHICAD Live Connection 2.2 User Guide 51



ARCHICAD Nodes

I Curtain wall Default Settings ? x

B v 4I>\: _
————— Synchronize
d I 1

~ B curtain Wall System ~ [E] GRID PATTERN AND PREVIEW b Citve
q

[H seheme L S s——— — — b ¢ Domain g Curtain Wall

I Frames v I "
Fixed Sizes W d E:lnrnal-SKh
il s v M) q CW Settings
> ds

I Panels
Width

£ Junctions
»
|- m
E:) 3

= Accessories
00

[Elzoa oot =

Rows:

Fixad Sizes

[E1 3000 qQr =

B |s000r

Partial Pattern | [ oistinct Panel g Hl so00

~ [ PATTERN ORIGIN

B B T8 GH sterwi paem il
BB T sasontonn B,

ZZ < Finish - Wall » e

The following input parameters define the Scheme’s grid pattern:

Vertical and Horizontal Grid Pattern

Expects a list of real numbers that define the CW Scheme’s pattern via the number and size of the
grid cells.

Example: The Horizontal Grid Pattern value is A, B. The Vertical Grid Pattern value is 1, 2, 3. The
result is a Scheme with a total of 2x3, that is 6 grid cells.

Crossing Frame Pattern

Expects a list of Boolean values. Use these to define the direction of the Crossing Frame placed
inside a given panel of the grid: from lower left to upper right corner, or from upper left to lower
right corner. The number of values entered must correspond to the number of Scheme cells even if
you do not want to place a Crossing Frame in each panel. (The Crossing Frame Class parameter
defines whether to place a Crossing Frame or not; see below.)

Frame Settings and Panel Settings

Use these parameters to define the types of Frames and Panels to use. Consider it as a product
catalog: each Frame Class and Panel Class has a particular geometry and appearance. The architect
can choose among these to design the Curtain Wall; not all items in the catalog must be used. (In
Grasshopper, these are defined in the Frame Class and Panel Class input parameters - see below.)

Assign values to the Frame Settings and Panel Settings input parameters using the “CW Frame
Settings” and “CW Panel Settings” components, or the Favorite Input Node. Each such input adds a
new item to your “catalog” of projects - that is, to the available Frame and Panel Classes.

See details at CW Frame Settings Component and CW Panel Settings Component.
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Frame Classes

The Frame Class, assigned to the Frame’s axis, defines the appearance and profiles of Frame
geometry. A Curtain Wall can use five kinds of Frames: Boundary, Corner, Vertical, Horizontal and
Crossing. Thus, the CW Scheme Settings component uses five Frame Class input parameters, each of
which expects an integer-type value. Each integer refers to one of the Frame Classes as defined in
the Frame Settings input parameter. Hover over the Frame Class parameter to see available input
values in the tooltip.

If Frame Settings inputs do not have any values attached, you can still choose from predefined
Frame Class parameters which are always available: -3 (= Corner), -2 (= Boundary), -1 (=Division)
and 0 (= None). This is the predefined set of Frame Settings, which can then be expanded with
additional Frame Settings inputs.

e Boundary Frame Class

This is the Frame that forms the Curtain Wall’s outside Boundary. Though a Boundary Frame
consists of multiple segments, all segments have a uniform appearance, so the Boundary Frame
Class parameter requires a single integer as input.

e Corner Frame Class

Corner Frames may be generated within a Curtain Wall - for example, if the Curtain Wall is
generated along a segmented polyline. Where the planes meet, Curtain Wall segments are
joined via Corner Frames. Like Boundary Frames, Corner Frames are uniform for the entire
Curtain Wall element, so the Corner Frame Class parameter requires a single integer as input.

e \Vertical, Horizontal and Crossing Frame Class

The Grasshopper algorithm considers that each Scheme cell contains a Vertical, a Horizontal and
a Crossing Frame segment. The corresponding input parameters thus expect a list of integers -
one for each cell in the Scheme. If the input list contains more or fewer numbers than the
number of Scheme cells, then the CW Scheme Settings Components automatically truncates or
augments the input list using a default integer (in this case, a yellow info pop-up appears).

( Synchronize

Boundary
Curtain Wall
( External Side @

¢ CW Settings

Panel Class

Assigning the Panel Class input to a panel’s boundary defines that panel’s appearance and cross-
section. Since the Curtain Wall has one Panel type (as opposed to the Frame, which can be e.g.
Boundary or Crossing), the CW Scheme Settings component has a single Panel Class input, which
expects integer values. Each input integer refers to a particular Panel Class, as set up in the CW
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Panel Settings component. Hover over the Panel Class tooltip to see the list of available integers and
what they mean.

If Panel Settings contains no values, the Panel Class input can always use the default value of 0
(=Deleted). This basic setting is always available; you can expand this set by inputing values into
Panel Settings.

For the purposes of control from Grasshopper, each Scheme cell contains two panels - because of
the possibility that a Crossing Frame creates two panels (this is the case even if the Crossing Frame
value is 0 (= None), that is, if the Crossing Frame is invisible). Therefore, the Panel Class parameter
input expects a list of integers whose number is equal to the number of cells in the Scheme (as
indicated above, this number is doubled to account for Crossing Frames). If the number of input
integers is less than this number of panels, then the leftover values are set to 0 = Deleted. If the
number of input integers exceeds this number of panels, then the extra values are ignored - as
indicated in a yellow warning pop-up.

CW Frame Settings Component

Use this component to control the editable parameters of Frame elements in the connected
ARCHICAD project.

[ Curtain Wall Default Settings ? X
[ Default

~ [ curtain Wall system Frame Class Name Type
[Escheme Cormer Frame. Regular .h Cap 22
1= e Boundary Frame Built-in Frame

GH - Custor tain Wall F 1D
Add.. Remove. GH - Custom Curtai UL Frama

~ 47 MULLION FRAME TYPE AND GEOMETRY

Built-in Frame

=)
= [*]
250 200 &
T 1§
e 30
et
20
Frame Intersection Priority
L} s
+ B CURTAIN WALL FRAME SETTINGS
» [E] CLASSIFICATION AND PROPERTIES
£ZF < Finish - Wall 3 Cancal oK

Attach the CW Frame Settings component to the Frame Settings input of the CW Scheme Settings
Node: the Frame can now be referenced and accessed by the Frames of the Curtain Wall.

See CW Scheme Settings Component.
e Class Name: Class Name of ARCHICAD Frame Settings.

e Width/Depth: The Frame’s Width and Depth values. The value must be a positive number (a
negative input value is interpreted as zero in ARCHICAD). If the input value is invalid, a yellow
warning appears.

e Offset: Frame back offset from panel centerline. The value must be a positive number, and it
must be less than the Depth value. If the input value is invalid, a yellow warning appears.
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¢ Depth of Inset/Width of Inset: The value of the Panel inset must be a positive number. If the
input value is invalid, a yellow warning appears.

e Intersection Priority: Controls the ARCHICAD Frame’s intersection behavior. The input value
must be a positive whole number between 1 and 19. If the input value is invalid, a yellow
warning appears.

CW Panel Settings Component

Use this component to control the editable parameters of Panel elements in the connected
ARCHICAD project.

Attach the CW Panel Settings node to the Panel Settings input of the CW Scheme Settings Node: the
Panel can now be referenced and accessed by the Panels of the Curtain Wall.

See CW Scheme Settings Component.
e Class Name: Class Name of ARCHICAD Panel Settings.
e Thickness: The Panel’s Thickness.

I Curtain Wall Default Settings ? X
By Default
e o
v [ curtain wall System Panel Class Name Type
[Qsmsme Distinct Panel Built-in CW Panel ﬁ So
10 Frames [Main Panel Built-in CW Panel [
I Panels ‘I GH - Custom Curtan Wall Frame 1
¥ Junctions [ ——

Add. Remove...

= [E] MAIN PANEL TYPE AND GEOMETRY

Built-in CW Panel

ﬁ GH - Custom Curtaim Wall Panel 1

u GH - Custom Curtaim Wall Panel 2

GH - Custom Curtam Wall Panel 3
» [EE CURTAIN WALL PANEL SETTINGS u

3 CLASSIFICATION AND PROPERTIES

£} < Finish - Wall » Cancel
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The Profile Settings Component

Use this component to access and adjust the Modifiers (if any) of Complex Profile elements in

Profile Manager -

¥ Manage Profiles

Choose Profile:

Grasshopper b
E & A A
Save
Use with:
Ox0
O]
Element Selection:
Capture Apply
» Design Layers
¥ Modifiers
Name H—H

] width Stretch
[] Height Stretch

ARCHICAD.
¢ Nominal Width »
(500)

- — A
g |35
£18

. @

z

)

3| - 7\

gé [ Al g l

E

o

=z

v P

= | S

¥ x =4
Fé\om‘\m 2} Modifier 6 {;;'mcimev':
(100) (300 (100)

21 Modifier 1
=] Modifier 2
,—’\: Modifier 3
2] Modifier 4
] Modifier 5
,21 Modifier 6

Example of a Profile Element with Modifiers

» Components - Default

» Uniform Profile Contours

Note: The Profile Settings component can be used only if the “Structure” parameter of the Wall/
Column/Beam’s Settings component is set to “Complex Profile.”
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Rectangular

& Circular
|SE  Complex Profile

When first placed, the Profile Settings component has no parameters.
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To assign Profile and Modifiers, use “Select ARCHICAD Profile” from the component’s context
menu.

Synchronize
Anchor Point
End Point
Column Settings

0 cowmn

|Proﬁ|e Settings

(B Enabled
& Bake..

| Select ARCHICAD Profile

Help...

In the appearing dialog, first choose a Profile: this will determine which Modifiers can be assigned
to the generated element. These available Modifiers are now listed. Check the box of the Modifiers
you wish to assign, then click “Select”.
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Synchronize
Anchor Point
End Point
Column Settings

Search Modifier:

[ Modifier 1
[ Modifier 2
[ Modifier 3
[ Modfier 4
] Modier 5

! - [ ] 4 [ Modifier 6
Concrete ConcreteSd:Edge Generic Beam

Column/Beam... Footing

Generic Column Grasshopper | Joist - Steel

[ I k.

i " Comel || [ S0t ]

The selected Modifiers now appear as new input parameters on the left side of the Profile Settings
node.

Synchronize
Anchor Point

End Point
¢ Column Settings

[] cowmn b

100y [y 100y )
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ARCHICAD Extract Settings Components

Use the Extract Settings components to access the Settings data of ARCHICAD elements.

Extract Settings are the inverse of Settings: Extract Settings output ;
parameters are the same as the Settings input parameters. l:f

output of Extract Settings is a fixed list of parameters. If a particular
output is not applicable to the given element geometry, then the output
value is “NULL".

For example: The output from the Extract Wall Settings component
includes parameters for Building Material, Profile and Composite. Yet any
Wall element can have only one of these three values, depending on its particular structure. The
other two parameter values here are “NULL".

~
78
As input, you can attach Deconstruct components to Extract Settings. The U» %ﬁ
A~
@
A~
F

(o}

Generic b
Wall/Shell

| 10}
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ARCHICAD Reshape Components

Subtract Polygon Component

This component is used to cut a hole of any shape into an existing Fill, Slab or Single-plane Roof
element. First, connect the element to be modified to the Geometry parameter. Next, using the
Curve parameter, define the contour of the hole as projected to the horizontal plane.

The output will be an element of the type defined in the Geometry parameter, with a hole in it.

.....

Curve

Radius

1O

Segments

Fillet Radius

Notes:

— The Curve input defines the contour of the hole as projected onto the horizontal plane.
Therefore, on a slanted Roof, the hole is created by intersecting the Roof with the straight
prism defined by the Curve input.

— If you input a Curve that falls outside of the element in which the hole is to be cut, then the
Subtract Polygon component will result in another copy of the element to be cut, in
unchanged form (no hole).

Add Polygon Component

This component works just like the Subtract Polygon component, except that it adds to the contour
of the Fill, Slab or Single-plane Roof, instead of subtracting from it.
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ARCHICAD Input Nodes

Input Nodes are special interface elements that reference certain data from
the ARCHICAD project, making these data available to Grasshopper. The
referenced data are continuously updated. Input Nodes can be attached to
Settings components to control attributes — such as Building Material,
Composite, Pen etc. — or the destination Layer of the generated elements. An
exception is the Favorite Input Node, which can be attached (instead of a
Settings component) to the main Design or Document component.

An Input Node is divided into two parts: click on its left side to select the Node

itself; click on its right side to modify its stored data.

Layer Input Node

Use the Layer Input Node to bring up the ARCHICAD
layer set in Grasshopper so you can define the layer
where elements generated by Grasshopper should be
placed. The Layer selection palette also includes the
layers’ status (show/hide, lock/unlock and 3D display
mode). Sort the layer list as needed (click the top of
any list column) to make layer selection easier.

Nearly all Settings components include a Layer-type
input (except the Settings components of CW Panel
and CW Frame).

Fill Pattern Input Node

rlb <G> ARCHICAD | aver }'l

Layer Name

ARCHICAD Layer
Interior - Partition

rFRFFFFFFFFFIFFIIIS

Interior - Fumiture:
@9  shel - Roof
ﬁ Site & Landscape - General
Interior - Stair
ﬁ Annotation - Structure
ﬁ Dimensioning - Structure
ﬁ Annotation - General
9 20 Drafting - Hotspot
B MEP-HvAC
@9 MEP - Bectrical
ﬁ Dimensioning - Site
ﬁ Annotation - Label
ﬁ Marker - Section
ﬁ Structural - Shear
ﬁ Structural - Bearing
Structural - Combined
Interior - Lamo

Bdension ~ ~

Cancel Select

Through this Node, the Fill Type attributes of the current ARCHICAD project are made available to
Grasshopper. At present, only the Fill Settings component can use this type of input. Use it to
control the fill pattern of elements generated by the Fill component.

( Synchronize

Curve

A&, 2D Fill

2D Viewpoint
Fill Settings

Pattern
Show Outline

Outline Type

Conorete Block
VECTORIAL FILLS
Scaleindependent

/777 Commen Brick

2 Fire Brick

Lightweight Concrete
E=Haypsam

V77 Steel

Brass/Bronze
Rubble

Rigid Insulation

=
==

Tangular Grid
Hexagonal
Facing Tile - Large Scale

V7 Face Bick e
77 wasonry Block

[t22--5 Structural Concrete

[ Praster

EElracing Tie

] Trangles
[ Grass
P77 Rubble - Large Scale M

Cancel Select

Note: The Fill Pattern Input Node can be attached to the Fill component only if you have
selected an option other than the “Cut Fill — Building Material” category from the Fill
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component’s context menu (because the Building Material already includes the fill pattern.) For
more information on Fill categories, see helpcenter.qraphisoft.com.

Pen Input Node
p |I—_r‘l | 0.35mm /099 Pt - Annotation - Markers
Accesses the Pen attribute set of the connected EEN.NEEENENEENEN | -
. . . ENNENEEENENEEEEE ™

AR(?HICAD prOJect'. Currer?tly, this Input Nodg is =..=.===.=.==.== = =
available for the Fill, Polyline and Spline Settings EECE EEECE EECEE B
components. ] [ |

. ANEEENEEEENEEEEEee
Line Type Input Node mERRCTREERCEE .
Lists the Line Type attributes of the ARCHICAD Caneel Seleet

project. Currently, the Fill, Polyline and Spline
Settings components accept this type of data.

Surface Input Node

Accesses the Surface attribute set from the connected ARCHICAD project. Currently, this Input Node
is available for only the CW Frame Settings and CW Panel Settings components.

Building Material Input Node
Lists the Building Material attributes of the ARCHICAD project.

ll Bnck Structural
Common Brick & 720
,é Brick - Common Bond

l:‘ l:‘ Air Space l:‘ l:‘ Air Space - Frame 2
. l:‘ Aluminium @ . Brick

72 Brick - Firish

l:‘ Concrete l:‘ Concrete - Structural

@ . Concrete Block - Filler @ . Concrete Block - Structural

% l:‘ Fiberboard @ l:‘ Fire Procfing

[ GENERIC - ENVIRONMENT [ ] GENERIC - EXTERNAL CLADDING

I:‘ GEMERIC - EXTERNAL MEMERANE

GENERIC - EXTERNAL FILLER

[ GENERIC - INSULATION [T GENERIC - INTERNAL CLADDING
[ ] GENERIC - INTERNAL FILLER [] GENERIC - PREFABRICATED
GENERIC - STRUCTURAL [] Glass
Gravel l:‘ Gypsum Plasterboard
l:‘ Gypsum Plasterboard - Waterproof m l:‘ Insulation - Fiber Hard
m l:‘ Insulation - Fiber Soft m l:‘ Insulation - Mineral Hard
EZ3 l:‘ Insulation - Mineral Soft % l:‘ Insulation - Plastic Hard
% l:‘ Insulation - Plastic Soft EZ3 . Insulation - Themmal Break
l:‘ . Iron E . Masonry Block - Filler
m . Masonry Block - Structural "m . Membrane - Rainproof A
Cancel Select

Most Settings components of 3D elements include this type of input. Elements that can have
composite or profile structures (Wall, Slab, Shell, Roof, Beam, etc.) will include the Building Material
Input Node only if the Structure value is set to Basic. If the Structure value is set to Composite or
Complex Profile, then the Profile or Composite Input Node will be available instead.
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Synchronize
Curve a Slab
_ Slab Settings
[poses | &
Enabled
@ Bake...
Structure of ARCHICAD Slab v [ Basic
@ Help. E2 Composite

Profile Input Node

Lists the Complex Profiles defined in the ARCHICAD project. Use it to define the cross-section of a
Wall, Beam, or Column element that has a Complex Profile structure.

Q Precast Beam T

Synchronize

Curve % Beam

Beam Settings

BeamSetP &y

Enabled
Bake...

Structure of ARCHICAD Beamn

3 | Rectangular

Help...

@ Complex Profile

Click the right side of the Profile Input Node to
open the selection palette. Filter the list by using
the element type buttons at the top left corner of
this palette.

Click the button at the bottom left to display the
list by either Icon or List format.

Note: If all three element-filter buttons are
active at top left, then you will see the full list
of profiles. If only the Wall button is active,
then only the profiles available for Walls are
listed.

EHQ Precast Beam T b :

=l (o]
Precast Beam T
300x 360
=
8
~
ﬁ v [
Brick Wall Belt Ledge Precast Double T
T
N
Precast Beam T Precast Inverse  Precast Beam | 02
Tee
¥ = " v
| Concad || Sokat |
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Composite Input Node

Lists the Composite attributes of the ARCHICAD project. Available in the Settings components of
Walls, Shells, Roofs and Slabs whose Structure is set (in their context menu) to Composite.

2D Viewpoint Input Node

Use the 2D Viewpoint Input Node to access the Viewpoints of the current ARCHICAD Project. By
attaching this node to the Document components (2D Curve, 2D Fill, 2D Spline), you can control the
2D Viewpoint in which the 2D elements should be generated in the ARCHICAD project. Open the
Node’s palette to access a tree structure corresponding to the ARCHICAD Project Map. Note that
only the 2D views are available (Section/Elevation, Floor Plan, etc.); no 3D views are available.

Mavigator - Project M... n

|l BI 0.Ground Floorb ® [E. o @

El- Untitled
- Stories a [P Untitled ~
E : Fl IE| Stories
RN ) ol Foor] 5 1. story
= E!evations [ 0. Ground Floor
7 Sections
a 7 Elevations

‘. West Blevation

Q East Elevation [Autc
T Morth Elevation [Au
1 South Elevation [AL
T West Elevation (Aut
E Interior Elevations
Warksheets

(B etails
30 Documents W
£ >
3 & X
Cancel Select D TS

Story Plane Input Node

Produces horizontal planes (parallel to the X-Y plane) based on the Story heights of the ARCHICAD
project. Use these planes to define the reference input curves of the element-generating
components: this way, the elements (e.g. Wall, Slab, Beam) will be generated in ARCHICAD at the
correct elevations.

lmb Plane Circle

Radius

slab Settings

synchronize
Curve & > Slab

! E % List of Stories b

No.  Name Elevation

2 Story 6

0 Ground Floor 0
Cancel Select

Grasshopper-ARCHICAD Live Connection 2.2 User Guide 65



ARCHICAD Nodes

Zone Category Input Node

Attach this Input Node to the Zone Settings component to define the Zone Category of the
generated ARCHICAD Zone element.

The main function of Zone Categories is to use colors to visually distinguish different types of spaces
in your project.

Synchronize

Curve [% E

( Stamp Position

Closed

Vertices
j F Polyline D

. .
0 GROSS AREA Zone Settings

1  Residential and Recreation
2 Office

3 Production & Research

4 Storage & Sales

5  Education & Culture

6 Medical Treatment

7 Other Usage

8  Technical Equipment

5 Communication & Access

OO

|

I

| Cancel || Select

Favorite Input Node

Lists the set of Favorites of the ARCHICAD project.

Note: In ARCHICAD, the Favorites feature allows you to save sets of configured tool settings by
name. For more information, visit helpcenter.qraphisoft.com.

Unlike the other input nodes, the Favorites Input Node is attached not to the Settings Component,
but directly to the Document or Design Component (“Settings” parameter) which generates the
element. By attaching the Favorite Node (instead of a Settings component), you are thereby
defining all parameters of the generated element in one step.
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{ Synchronize

m Generic Interior Wall b

D Show Wall Favorites

[_:-IGeneric Exterior Wall
DGeneric Interior Wall
[ Structural Wall

[___.-l Partition Wall

Cancel

cNENOEOEroBed 904/ =

Wall Favorites
Column Favorites
Beamn Favorites

Slab Favorites

Roof Favorites

Shell Favorites

Mesh Favorites
Morph Favorites
Window Favorites
Door Favorites
Object Favorites
Curtain Wall Favorites
CW Frame Favorites
CW Panel Favorites
CW Scheme Favorites
Fill Favorites

Zone Favorites
PolyLine Favorites

Spline Favorites

Note: The 3D position of elements generated by Grasshopper (such as the Offset from Home
Story parameter in the Settings dialog) are defined in the mandatory input data of the
Document and Design components, which generate the element. (For example, the elevation of
a generated Slab is determined by the Curve parameter of the Slab component.) Such
mandatory input data are not affected by Favorite settings.
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Workflow Examples

Example 1: Use Rhino to Create Freeform Shading System

In this workflow, we create the geometry using Rhino’s freeform modeling capabilities, while also
taking advantage of ARCHICAD’s BIM capabilities. The task is to design a shading system that
extends between two curved splines.

1. Begin in Rhino: create the 3D curved splines.
2. In Grasshopper, use these freeform geometries as the input parameter.

3. Use the Divide Component to generate the division points needed for the shading system.

Curve defined in Rhino —

Count f Tangents

[ Number of Divisien Points ‘ & 22 }

@ |

Divide Curve
Points

Curve defined in Rhino Curve
Count f Tangents

Kinks

Parameters

Move

{ Geometry o Geometry

Number Slider
Height of Facade | © 22

Motion Transform

Untitled - Rhinoceros 5.0 Not For Resale Lab - [Top] S C
File Edit View Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Panels VisualARQ  Help

Curve or Edge to reference ( Mode=Reference : =
Command: | %

Top |

9.8, T \‘\,\

=

Perspective | Top | Front | Right = <+
CPlane X277 y-875 z0.00 Meters Wl Cefault Grid Snap = Ortho | Planar | Osnap = SmariTrack = Gumball Record History Filter | CPU.

&S e Mo
Mt e AR &

oo
o

Splines drawn in Rhino with the Curve command
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4. At each division point, place an AC Column component; at each spline, place an AC Beam
component.

Synchronize
Curve =3 Beam

Beam Settings

Paints

Curve defined in Rhino ¢{ & :
MY b . .

C?unt f Tangents synchronize
Ll Anchor Point
End Point U S
Curve defined in Rhino { &) ) Collin Setings

Synchronize
Curve =3 Beam

Beam Settings

| i Untitled - GRAPHISOFT ARCHICAD-64 20 - 0 R
| File Edit View Design Document Options Teamwork Window Help — 8 x
O- 8 -@Exkarr 8 gsao- ,
: [S. Ground Floo [Posan x {7[South Elevation] Tandl
] Desigr
| B
|
(R0 ‘
(== |0 |
<=
=
=
M DG Q@ 2 |@Q curentzooms | & oo b |mm 1100 »|£F 02Drtting » | B Entire Model » | U 03 Architectu..» | 5] 03Building ... » | 0§ No Overrides »
Enter First Node of Wall, [_‘l:l

Generated BIM model in ARCHICAD based on 3D Rhino curves

5. You can fine-tune the geometry in Rhino by adjusting the original spline geometry (use the
PointsOn command).

6. To define the Building Material attribute or Core Dimensions of the generated Columns, attach a
Column Settings component to the corresponding parameter of the Column component.

Bi terial

Column Settings

Synchronize
Curve ©y Beam

/Elilde_c_un‘g Beam Settings Synchrenize
Curve Points Anchor Point

Count f Tangents t End Point ﬂ Column
q Kinks Parameters Column Settings

Divide Curve

Move Synchronize
Geometry Geometry Cutve 5y Beam
Notion Transform Beam Settings
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Example 2: Use ARCHICAD Input to Build a Parametric Tower

In this workflow, parametric design is based on an existing ARCHICAD project, using input that

originates in ARCHICAD.

The task is to create a mass model of a high-rise atop a six-sided base, which has already been

defined in ARCHICAD.

1. In Grasshopper, use the 2D Curve parameter node to reference the six-sided geometry in the
ARCHICAD project.

2. Create an array of the polyline to draw the outline of the slabs on each story.

Curve
Polyline defined
in ARCHICAD
Number Slider . Geometry
0 2.700 Unit vector . i
——

Y 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 - O R
File Edit View Design Document Options Teamwork Window Help -0 x
0o & g 2| B + - O~ o -[Em x| e HLG S -

[ o [0, Ground Floor] % [PED/an Eh -

2 Mt Building Site
~ Design i

Polyline
J wan 2 Type: Sofid Line
9 Layer: 2D Drafting - General

B Door o

Ea ‘Window lf

D Column f

B2y Beam

<> Slab

Connected to:

ParametricTower.gh

Break Connection ':3‘

Send Changes

Select in GH

P @Q|a 10% b O 0,00° b | i 1:100 v | & 02Drafting » | B  Entire Model » | | 03 Architectu...» | [3] 03 Building... » | T No Overrides

Click an Element or Draw a Selection Area. Press and Hold Ctrl+Shift to Toggle Element/Sub-Element Selection. ]

The cross-section of the tower is defined in ARCHICAD

3. Apply a rotation transformation to the array of polygons to create a more complex shape.

4. Use the rotated collection of polygons as the input parameter for an AC Slab component to
create slabs on each story, which can be adjusted as needed using the transformation features.
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5. Create division points along the slab outlines: these will constitute 3D curves.

Area
Curve
Linear Array =
UnitZ  Synchronize
02700 cEEIELY Geometry ) Curve &> slab D
B angle g ( slab Settings
Plane Transform
o4 Series
o6 b
fa 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 = = £
-8 x

File Edit View Design Document Options Teamwork Window Help

o | & L2

["510. Ground Floor] [Prosan x
Slab (Locked)
~ Design Structure; Generic Slab/Roof|
[j Top Elevation 19000
L Thickness: 300
Layer: Structural - Bearing
B Door . Story
H window Muttiple Elem ents (TAB)
U Column !
i
5=y Beam !
> slab
Connected to:

ParametricTower.gh

Break Connection’ @
Send Changes

yz x
1100 | £  02Drafting » Entire Model | |J 03 Architectu..» | [5] 03 Building ... »
=]

Select in GH
L)

DC AP & |@ cumentzooms | o 0,00°
Click an Element or Draw a Selection Area. Press and Hold Ctrl+ Shift to Toggle Element/Sub-Element Selection.

Slabs of the tower generated in ARCHICAD

BE=HEH#- v 0- 6 -Emx|earr rmaaseo-
Sinlid
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6. Use these curves as input parameters for AC Beam components to model the building’s twisting

frame.
Rotate 0 Synchronize
Geometry Geometry ) Curve é> Slab
@ Angle g ( Slab Settings

Transform

Plane

Interpolate Synchronize

Divide Curve Flip Matrix

Points Vertices Curve Curve QZ:} Beam
| Count f Tangents Degree a Length Beam Settings
Parameters Periadic
( KnotStyle Domain

i 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 - O IR
File Edit View Design Document Options Teamwork Window Help -gdx
10 | @ 2 2 o= 8O- 8 B x| ea B2Q®-

¥~

[Peosan x

(=
IV_L| [0. Ground Floor]

1 Marguee

* Design
[ wan
D Door

E Window
i lmmp— 7 Layes: Structural - Bearing
D Column ! 3 — = Stony: 2. Story
i
BZ Beam
<> slab

Connected to:
ParametricTower.gh

Break Connection ‘?_7\,'

Send Changes

Select in GH
<) & ‘ @ & ‘Q Current Zoom ‘

Click an Element or Draw a Selection Area, Press and Hold Ctrl+5hift to Toggle Element/Sub-Element Selection. ]

The division points along the slab outlines define 3D curves.
AC Beam components attached to these points create the twisted frame in ARCHICAD.

7. Atany time, you can edit the original six-sided polyline in ARCHICAD, thereby modifying the
cross-section of the entire high-rise: the 2D Curve parameter, the basis for the Grasshopper
code, remains associated to its parent element in ARCHICAD.

i i 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 o B /) 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 = =
File Edit View Design Document Options Teamwork Window Help —@x File Edit View Design Document Options Teamwork Window Help
IV PIIN e 08 -BExeaTr o ma| o] ez 2| [BEERE# - 0 D - 8 B x|l
[5te. Ground Floor] = [JBosan BB - l"_H[o‘ Ground Foar] [JEo/am x [Maohd
™1 Marquee Building Site "] Marquee
~ Design ~ Design
[ wan ) wan
] ooor [ ooor
B window B window
[ coumn a [J cotumn
T3 Beam Ty Beam
£ sian <> shb

Connedted to:
ParametricTower.gh ParametricTower.gh
Break Connection ()

Break Connection| (1)

Send Cha Send Changes
Select in GH

Select in GH
D ala 1% »|o o @m0 v | ozpmting
=]

O CA|® 4 |@ cumentZooms | 0,00° @ ot v

Click an Element or Draw a Selection Area. Press and Hold Ctrl+Shift to Toggle Element/Sub-Element Selection. ]

If you edit the original polygon in ARCHICAD, and then press the Send Changes button on the
Grasshopper Connection Palette, the model’s entire geometry is modified accordingly: the 2D Curve

parameter is associative to its parent element.
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8. To change the cross-section of a Beam, attach a Beam Settings component to the Beam
component’s Settings parameter. From the Beam Settings context menu, click on “Structure of
ARCHICAD Beam”, and select Complex Profile. As a result, the set of input parameters of the
Beam Settings input is modified and now includes the “Profile” parameter on the left side.

Geometry

Transform

Curve

Kinks

Synchronize

Curve a Slab

Slab Settings

Divide Curve

Points

Count ’r Tangents
Parameters

Beam Settings

e —

Enabled
Bake...

]

Structure of ARCHICAD Beam

Rectangular

JE  Complex Profile

Help...

Synchronize

‘ Curve = Beam

( Beam Settings

9. Attach a Profile Input Node to the Profile parameter. Click on the right side of the Input Node to
bring up the Profile Selection palette, which lists all the profiles defined in the ARCHICAD
project. In the upper left of this palette, deselect the Wall and Column elements, so that only
profiles defined for Beams are visible, making it easier to choose the right one.

m% RHS Cold Closed
=1 (0]
RHS Cold Closed

120x120
. (S
I

S — —
Precast Beam | 01 Z Beam

L

~
C Section - Lipped

v

C Section - Plain ~ Z Section Column Equal Angles
nist RHS Cald Clnsed T Steal
| Concad || Sokat |
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Example 3: Use Rhino to Create a Custom Curtain Wall

In this workflow, we generate a custom Curtain Wall from a curve defined in Rhino.
Begin in Rhino: Create the spline and a point.

N

In Grasshopper, use these geometries as the input parameter.
Use the Construct Domain Node to define the Curtain Wall height.

ol

Place the Curtain Wall generating component and attach the inputs:

Synchronize
Curve
Domain EEE CurtainWall D

| Domain Start | o 0 External Side
CW Settings
Gammbay  c
8 CustomCurtainWall (22 KB) - Rhinoceros 6 Not For Resale Lab - [Top] — O X
File Edit View Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Panels Help
Standard  CPlanes  SetView Display Select Viewportlayout Visibility Transform  CurveTools  SurfaceTools  Solid Tools Mesh Tools  RenderTools  Drafting  Newin V6 &
POVPURNURa TEW RN AR VP
Name of object set to hide. Press Enter to hide with no named set.: "A" A
Command: _Enter v
Command: | 3
\ ., - >
sl &

) 1 (&
@, 4
)
" -
<3 &
0.8 | -
9, = =
Bl £
4152
& S
N S :
T c
o5 1o
8., [ ]| . , A . ]

B 8. e : : HH

Perspective  Top Front Right < v
CPlane x-9.66 y1.26 z0.00 Meters [l D<fault Grid Snap Ortho Planar Osnap SmartTrack Gumball Record History Filter Available physical memory: 18946 MB
Grasshopper Code with Rhino Input Elements
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7 CustomCurtainWall - GRAPHISOFT ARCHICAD-64 22 - o x
File Edit View Design Document Options Teamwork Window Test Help 3
Wolass b Z e s 00 -BEX RO CHS HEGS -

Main:

| N
‘ N [510. Ground Fioor] % []) Generic perspective (30 / All % [-]5-01 Building Section [5-01 Building Section] [ [South Elevation] D~
Design

St -

I I

% Il l I il
@ | [ |
=

Documer

More

DR @r @ N/A URZ N/A r = 1:100 F= Custom » Entire Model  » |} 03 Architectural 100% [E] 03Building Plans » CF  NoOverrides » /) 01ExistingPlan » (@  Simple Shading »

Click an Element or Draw a Selection Area. Press and Hold Ctrl+Shift to Toggle Element/Sub-Element Selection. [® GRAPHISOFT ID

Resulting Curtain Wall, with Default Settings
5. Attach and define the CW Settings Component:

[l Curtain Wall Default Settings

Default

v B curtain Wall system ~ D1 GEOMETRY AND POSITIONING

[E scheme
Nominal ...
5 FJ% 0000

H panels

—
¥ Junctions
= Accessories Home Story: Reference Line:
Flexible (by Elevation) i fee na
to Project Zero| »| to Panel Center| |

_EB:"_I 250

——t o

~ [Z FLOOR PLAN AND SECTION Synchronize
- FLOOR PLAN DISPLAY A Curve
Show on Stories All Relevant Stories & N .
N y . =] Domain EEE Curtain Wall
Floor Plan Display Projected with Over...
Projection Mode Hybrid (=] External Side
Show Projection To Floor Plan Range 54 CW Settings
- CUT ELEMENTS
Override Frame Type's Attrib... O
T/ Frame Cut Lines Solid Line v
~ P MEMBER PLACEMENT
Place Junctions: Place Boundary Frames:
%% O Atall Grid Points LI Onside Boundary
577 @onebyone ||l @ center on Boundary
O outside Boundary
Relation To Zones: | zone Boundary v

» [E] CLASSIFICATION AND PROPERTIES

< Finish - Wall > Cancel
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6. Attach the CW Scheme Settings Component to the corresponding input, then use it to define the

Pattern.

[l Curtain Wall Default Settings
B

v EH curtain wall system
[E scheme
I3 Frames
T Panels
¥ Junctions
= Accessories

= [ﬁ GRID PATTERN AND PREVIEW

Columns:

Fixed Sizes ~ }

Py

PR 3 S

0030

- 0025

ﬁ 1200 Tr||=

Fired Sizes M|
5 EN

# Height | | /7

s W
: 2 1500

: 3 600

|
|
[
[
Rows: |
[
|
[
|

N7

[E? 3000

e . :
| partial Pattern v [l a0

~ [ PATTERN ORIGIN
fﬂﬁ m EEI ﬁﬁ: Start with Pattern

5B H T secronsoron

£Z < Finish - Wall » Cancel

v H Distinct Panel

o
Bo

Synchronize
Curve
Domain [FF7} Curtain Wall
External Side
CW Settings

In our example, create a 2x3 pattern, consisting of 2 vertical and 3 horizontal divisions.

@ Vvertical Grid Pattern as list
Pattern of vertical grid lines (column sizes) of ARCHICAD Curtain Wall.

2 locally defingd values...
0.%
0.3

A

@ Horizontal Grid Patter as list

Pattern of horizontal grid lines (row sizes) of ARCHICAD Curtain Wall.

3 locally definad valugs...
09

7. Define the Crossing Frame Pattern. (If you don’t need a Crossing Frame, define it anyway: set its
class to 0=None). With the Crossing Frame, the divisional pattern 2x3=6 is now doubled to 12, so
the program now considers the pattern to contain 12 Panels.

Q@ Crossing Frame Pattem as list

Crossing Frame Pattern of ARCHICAD Curtain Wall.
TRUE = top left to bottom right (backslash),
FALSE = bottom left to top right (slash).

6 locally defined values...
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8. The Frame Settings input can be of two types:
e CW Frame Settings Component (see below), or

e Favorite Input Node (see description at Favorite Input Node). This enables access to the existing
CW Frame Favorites of the connected ARCHICAD project.

In our example, one Frame and one Favorite have been attached:

| “ GH - Custom Curtain Wall Frame 1 *\

)
(& Frame Settings as list

Frame Class Settings of ARCHICAD Curtain Wall.

2 values inherited from 2 sources...
Curtain Wall Frame Sattings
Curtain Wall Fame Settings

9. Similarly, the Panel Settings input can be of two types:
e CW Panel Settings Component (see Step 13 below), or

e Favorite Input Node (see details at Favorite Input Node). This enables access to the existing CW
Panel Favorites of the connected ARCHICAD project.

In our example, one Panel and three Favorites have been attached:

{& Panel Settings as list
Panel Class Settings of ARCHICAD Curtain Wall. _

& values inherited from & sources...
Curtain Wall Panel Settings
Curtain Wall Panel Settings
Curtain Wall Panel Settings
Curtain Wall Panel Settings

mau.cmmmmmw;umu}

' u GH - Custom Curtain Wall Panel 2 bt

1
= ;u GH - Custom Curtain Wall Panel 3 ])

10. Define Corner Frame Class and Boundary Frame Class, using the set of Frame types defined via
Frame Settings.

Choose one Frame Type for each of these classes as follows:
e Right click to open the context menu
e Choose Set Integer
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e Enter the code corresponding to the Frame Type

€ Comer Frame Class

2= Boundary.

-1 = Division,

0 = None,

1 = Built-in Frame

-] "2 = GH - Custom Curtain Wall Frame 1,

&s?‘sim Class to Comer Frames by referencing items of the collection in Frame Settings input. |

[ Empty Integer paramater

=) |

0 = None,
1 = Built-in Frame

"2 =GH - Custom Curtain Wall Frame 1.

As?‘siqn Class to Bound fi ing an item of the collection in Frame Settings input.

| [ Empty Integer parsmeter

11. Define Crossing Frame Class, Vertical Frame Class, and Horizontal Frame Class, using the set of

Frame types defined via Frame Settings:
For each Frame Class (Crossing, Vertical, Horizontal):
e Right click to open the context menu
e Choose Set Multiple Integers

e Enter the codes corresponding to the Frame Types - one code for each (in this case, six):
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Crossing Frame C

Wire Display

Manage Integer collection

Clear values

Internalise data
Extract parameter

@ Help...

Crossing, Vertical and Horizontal Frames
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12. Define Panel Class:

r

<@ Panel Class as s

1 = Built-in CW Panel,

2 =GH - Custom Curtain \Wall Panel 1.
3 = GH - Custom Curtain Wall Panel 2,
4 = GH - Custom Curtain Wall Panel 3,

Assign Class to ARCHICAD Curtain \Wall Panel by referencing an item of the collection in Panel Settings input. |
0 = Deleted

2 locally defined values..

1
2
2
2
2
1
1
3
3
&
&
4
&

Using the set of Panel types defined via Panel Settings, choose one Panel Type for each, as follows:

e Right click to open the context menu
* Choose Set Multiple Integers

e Enter the codes corresponding to the Panel Types - one code for each Panel. In this case, there
are 6 divisions in the Scheme; due to the Crossing Frame, each division consists of two elements,

for a total of 12 Panel elements.
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Panel Class

Wire Display 3

Principal

Reverse

Flatten

Graft

Simplify

Expression »

A
PEEEO®

R I

Set Integer »
Set Multiple Integers »
Manage Integer collection

Clear values

Internalise data

Extract parameter =
d o E § &
T @ Commit changes |
© Cancelchanges

13. Attach the CW Frame Settings Component as an input to the CW Scheme Settings Component,
via the Frame Settings input. This enables access to the existing Frame Types of the connected
ARCHICAD project. You must enter the Class Name; all other parameters are optional.

IR curtain Wall Default Settings ? x
(= Default
~ Bl curtain wall system Frame Class Name Type

[ scheme Comer Frame Regular_hCap2z  ©

Drame: Boundary Frame Built-in Frame

W Panels

2 Accessories Transom Frame Built-in ..ed Frame
ﬁo. R—r——)
ﬁ [EP-3F —

GH - Custem Curtain Wall Frama 1

Add.. Remawve

= £P) MULLION FRAME TYPE AND GEOMETRY

I Built-in Frame. .I—-ﬂ'

Frame Intersection Priority:

] s

3 Ecumnmurmssmnﬁs
3 ammmnmnmm

& orave | e e
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14. Attach the CW Panel Settings Component as an input to the CW Scheme Settings Component,
via the Panel Settings input. This enables access to the existing Panel Types of the connected
ARCHICAD project. You must enter the Class Name; all other parameters are optional.

I Curtain Wall Default Settings 2 x
(= Default
ﬁol-- e

~ Bl cunain wall system Panel Class Name Type

[El scheme Distinct Panel Built-in CW Panel [ -

e T T .

I Panes “GH -~ Custom Curtam Wall Frame 1 b

¥ Junctions _ °wb_

= Accessories

Add... Remave..

= [E) MAIN PANEL TYPE AND GEOMETRY

Built-in CW Panel »

@E-JD-

» B cURTAIN WALL PANEL SETTINGS
» mnmmm
5 <> Finish - wall »

15. The custom Curtain Wall is complete.

T CustomCurtainWall - GRAPHISOFT ARCHICAD-64 22 - X
File Edit View Design Document Options Teamwork Window Test Help £
1 .

ol aF 2Rl H VOG- BER R LT UA RO -

Main

| [ S]] R
‘ ; ["S10. Ground Floor] x [ Basiccw 30/ All % [@)3D-01 Perspective [3D-01 Perspective] 7501 Building Section [5-01 Building Section] [ [South Elevation] D |
Design

N

=

A
Documer
More

Do AQer @ N/A r o N/A »| @ 1:100 » g Custom » EntireModel  » | 03 Architectural 100» [E] 03BuildingPlans » CF  NoOverrides » ) 01ExstingPlan » @  Simple Shading »|

Click an Element or Draw a Selection Area. Press and Hold Ctrl+Shift to Toggle Element/Sub-Element Selection. B GRAPHISOFT ID
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Important Notes

Parametric Behavior of Generated Elements

a

Unlike geometry that is embedded using Rhino’s “Bake” command, elements generated in
ARCHICAD remain associated to their generating code. Grasshopper uses an ID-based method to
retain its connection to elements placed in ARCHICAD. If the Grasshopper file is modified, the
ARCHICAD-Grasshopper Connection Tool will update the corresponding elements in ARCHICAD.

Elements generated by Design or Document Components in ARCHICAD are not just previews:
they are real, editable ARCHICAD elements. When Grasshopper creates these elements, their
status is locked. After you unlock them (Edit > Locking > Unlock), you can open their Settings
dialog in ARCHICAD in the usual way, and modify their parameters. You can also edit the
elements graphically.

File | Edit | View Design Document Options Teamwork Window Help
[ ¥ | Undo Lock Selection / Ground Floor Ctrl+Z Q] - - éz._t'{ [z x ‘ :,?@ A,

x []] 3D/ Al

I B Copy Ctrl+C

/? —

¢

I—/ % Paste Ctrl+V

e all select Al Ctrl+A

HroHs( e O

®11 Find & Select... Cirl+F
388 Search & Replace Text...

BEC

Grouping

Display Order

Locking

Move T Unlock
U

Align BP Unlock Al

3
3
Distribute 4
Reshape 4
Element Settings 4

Reference Line and Plane 4

Mesh

The locked status of elements generated by the Grasshopper code is similar to the “preview”
status in Rhino. Parameters of locked elements can be modified only through the Grasshopper
code. After the elements are unlocked, their parameters can be modified in ARCHICAD.

By default, a generated AC element’s parameters which are not controlled by the GH code will
have the same settings as the Default Settings of the corresponding tool in ARCHICAD at the
time the element was generated.

Certain parameters of generated AC elements (those which are used in the node of the
generating component or their Settings nodes) can be edited in Grasshopper, as well as in
ARCHICAD after the elements are unlocked. However, the Grasshopper-based parameter control
takes priority over that in ARCHICAD as long as the GH-AC Connection is active. If a parameter of
an AC component in Grasshopper is assigned a value (e.g. you add a Number Slider), then that
value will be applied every time the Grasshopper code is executed. If you previously assigned a
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custom value to that element parameter in ARCHICAD, then that custom value, too, will be
overridden when the Grasshopper code is executed.

If you modify the parameter of a generated element in ARCHICAD using the element’s Settings

dialog box, and if that parameter is not controlled in Grasshopper (either because the parameter
is not available in the generating component or because the parameter has no assigned value in
GH), then your modification remains in effect, even if the Grasshopper code is executed.

If the GH-AC Connection is not active, then the GH code has no effect on the ARCHICAD project.
You can then freely modify even those elements originally generated by Grasshopper code.
However, once you reactivate the GH-AC Connection, the GH code again takes precedence in
terms of controlling the parameters.

If you use copy-paste to replicate elements in ARCHICAD which were generated from GH code,
then the duplicates will lose their connection to the Grasshopper code. Use this method to
create and compare various designs by trying different values for the Grasshopper parameters.

Suspended Connection: As long as a dialog box is open in ARCHICAD, awaiting user input, the
connection between Grasshopper and ARCHICAD is suspended. Even if the user changes an
input value in Grasshopper, the change will not take effect until the dialog box in ARCHICAD is
closed. Feedback on the suspended connection is shown in ARCHICAD’s Grasshopper Palette:
the green connection icon stops spinning. In Grasshopper, the nodes with pending input in
ARCHICAD's direction will turn yellow. A message also pops up to inform the user of which
dialog must be closed before the Grasshopper ARCHICAD Connection is resumed.

File Handling

Elements generated by the Grasshopper code are fully functional, native ARCHICAD elements
that remain in the project even if the GH code is not available. Thus, an ARCHICAD project that
includes elements generated from GH code requires no additional management. It can be saved
as usual to any of the available formats. You can reopen the project without any problem even if
the original Grasshopper code is not available (the elements generated from GH code will be still
be present in the project).

In contrast to ARCHICAD, Grasshopper can have several projects (GH definitions) running
simultaneously in a single instance of the application. However, only one of these files can
communicate with ARCHICAD at a time. To define which of the running Grasshopper files should
be connected to ARCHICAD, use the “Connect Document to ARCHICAD” dialog box, available
from Grasshopper’s File menu.
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Grasshopper - Definition_2 - [m] x
Edt View Display Sohtion  Hel Definition_2
New Document Ctil+N
Open Document Cire0) Connect Document to ARCHICAD - o X
Recent Files > Select the Grasshopper document which should communicate with ARCHICAD. (D)
Save Document CilsS Status Name Path
Save Documert As Cirl+Shift+S @ @ @ @ o Q- (%) Definition_3" C:\Users\szabi\Desktop\Uj hiba\Definiti...
Definition_2 C:\Users\szabi‘\Desktop\Uj hiba“\Definttion_2.gh
Save Backup Cirb+Alt+5 Definttion_1 C:\Users\szabi\Desktop'Uj hiba"Definttion_1.gh
Connect Document to ARCHICAD..
Export GQuick Image Ctr+5Shift+Q
Port used for Live Connection with ARCHICAD 41678
i Export Hi-Res Image.
Document Properties
Create User Object.
[ ]
| i ' s
=
&8 Show In Folder
jr=1
=

Special Folders s
Preferences Ctrl+Shift+P
Close Definition_2 Cd+W
@ Mutosave complete (280 seconds ago) 0.9.0076

The path of the currently active document is shown in bold.
The green icon indicates which definition is currently connected to ARCHICAD.

e |f you connect an ARCHICAD PLN project to the Grasshopper file which contains the elements’
origin code, the two files recognize each other, and you can continue your parametric design.
For this reason, it is recommended to save these file pairs to a single folder, and to use related
file names.

e |tis currently not possible to use the ARCHICAD-Grasshopper Connection in a Teamwork setup
(that is, with ARCHICAD and Rhino installed on different computers). An ARCHICAD file that
contains elements generated from GH code can be shared as a Teamwork file, like any other
ARCHICAD project, if the GH-AC Connection is disabled.
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Accessing GDL Parameters of

ARCHICAD Library Parts

By default, Grasshopper cannot access the parameters of ARCHICAD Library Parts. However, you
can modify a Library Part’s GDL code to allow Grasshopper to access the object’s GDL parameters
(see steps below). This is recommended for users familiar with GDL programming.

Note: Geometric Description Language (GDL) is the programming language of ARCHICAD library
parts. These library parts, with file format GSM, can be loaded into your ARCHICAD project
through the Library Manager. When you open a new project with a default template, a standard

ARCHICAD Library is automatically loaded.

To modify an existing Library Part to enable Grasshopper to access its parameters:

1. Go to File > Libraries and Objects > Open Library Part.
2. Select the Library Part that you want to edit.
3. Click View or Open.

| Y

File | Edit View Design Document Options Teamwork Window Test Help

D New TR+ -~ @~ 6 -Em
E; Open »

[ CloseProject  Ctrl+Shift+W

x [ [armehair 01 21]

Save Ctrl+S

Cl Saveas.. Ctrl+Shift+S

@] Publish BIMx Hyper-model...

Interoperability 3 LY
External Content r Open Library Part from:
| Libraries and Objects »| T Library Manager...
Info » Manage BIMcloud / BIM Server Libraries... -
. [&] ARCHICAD Library 21 "
Plot Setu B Create Container.
= Up-: . E’ [BImg] Background Images 21
Plot... @ Extract a Container... £ Himg] HOR Images 21
Page Setup..  Ctrl+Shift+P 4 [ ARCHICAD Library 21.Icf
& print.. Ctrl+P New Object... + B3 opject Librany 21
= s 4 B 1. BAsiC LIBRARY 21
Bt cul-q |85 Open Object.. Ctrl+Shift+ 0
= 4 B 1.1 Fumishing 21
= || Save Selection as... »
E@ Em Appliances 21
Em Bathroom Accessories 21
@ 5 :
R Import Blocks from DXF/DWG B Beds 21
Er'l B cabinets and Shelves 21
S Em chairs 21
= Couches and Sofas 21 &
< < >
Docum
2
+—t
pren

4. The GDL Editor is opened in a new tab, where you can edit the object’s GDL code.

Open Library Part

[EE] ARCHICAD Library 21

= @
s &
|
Armchair 01 Armchair 02
21.gsm 21.gsm
r,
Armchair 03 Armchair 04
21.95m 21.gsm
-

&V

Bar Stool 21.gsm  Bean Bag 21.gsm

5. Click on the Parameters button (at left) to open the object’s parameter list.

6. Click New (at top left) to add a new parameter to the list.
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7. Set up this new parameter as follows:
Display: activate the red cross pushbutton to make the variable invisible on the user interface.
Variable: type "ParamcontrolByGrasshopper"
Type: Boolean

Name: enter any name

Value: ON
[ W SurveyPoint - GRAPHISOFT ARCHIC
File Edit View Design Document Options Teamwork Window Test Help
10 | R - 8 v &R0T x| \ @S -
|
[S10. Ground Floar] P 1armehair 03 21] x [JEo/an
o New Delete Q |3
o Display Variable Type Mame Value
= [EI::I B I m |ParamcontrolByGrasshopper I E* I Enable Grasshopper to co_-=
=] H A = Dimension 1 580
H - B O Dimension 2 680
° B i rad =] Height 300
- B gs_detlevel_3D_m 28 3D Detail Level Detailed
Details : gs_seat_height =] Seat Height 350
Parameters | B gs_2D_representation = 2D Representation
Migration H = gs_detlevel_2D Abc 2D Detail Level Scale Sensitive
Components B = gs_detlevel_2D_m 28 2D Detail Level 0
Descriptors
Scripts B = gs_SymbolType_Mask 28 Symbaol Type Enable Mask 4083
Master D H = gs_cont_pen U Contour Pen 4
2D /= = = gs_fill_type %, Fill Type 65
3D D H = gs_fill_pen U Fill Pen 19
Properties / - = gs_back_pen U Fill Background Pen 18
Parameter ] gs_min_space = Minimal Space
Interface = B = MSFront ey Minimal Space in Front 30
Enrar et | B = MSSide ey Minimal Space on Sides 150
Backward Migration ||[—] B = MSRear E_E Minimal Space Behind 300
H gs_3D_representation = 3D Representation
2D Symbol = B = gs_resol 28 Resolution 18
Preview Picture [ = gs_shadow = Shadow On
2D View ] B = gs_full_edit = Extra Hotspot Editing on
3D View D H )( AC_show2DHotspotsin3D = Show 20 Hotspots in 30 Off O
B )( ac_bottomlevel ey Bottom Level 1000
B )( ac_toplevel ey Top Level o
: gs_material = Surfaces
- = ne frama mat & Erama 12

8. After the new parameter is set, use File > Save as to save the Library Part under a new name to
the Embedded Library.

The newly modified, duplicate element is now available in Grasshopper.
9. In Grasshopper, place an Object Settings component on the canvas.
10. From the context menu, choose Select ARCHICAD Library Part.

11. From the appearing dialog, browse for the new element. Since Grasshopper detects the
ParamcontrolByGrasshopper parameter, the object’s GDL parameters are selectable on the
right. Every parameter that you check here will (after you click Select in the dialog box) appear
as an input parameter on the left side of the Object Settings component. From this point on, you
can define these GDL parameters, too, in Grasshopper.
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Select ARCHICAD Library Part B
Search Object | Search Parameter. |
<[] Embedded Lbrary Name Type  Variable Name
Linked Libranes
-4 BiMcloud / BIM Server Librares General
- Buikin Libraries [ Dimension 1 = A
[] Dimension 2 j=
Height = rarid
Suface A sudPart
-
Enabled
& Bake.
I Select ARCHICAD Library Part I—)
@ Hep. Test Object gsm
A Warning: Seing muhiple Library Pan paramet: ter i L i e i
ARCHICAD element. For more information, open the Grasshopper- ARCHICAD Live Connection User Guide from ARCHICAD's Help menu.

o

Note: Be careful when managing GDL objects via Grasshopper. Library part parameters are often
interdependent, and modifying one value will modify other values too. Grasshopper does not
detect this interdependence. If you adjust several values in Grasshopper which are
interdependent, an error may occur, if both Grasshopper and the GDL Parameter script seek to
modify the interdependent values simultaneously.

If contradictory information is given as parameter inputs for Library Elements in Grasshopper,
then objects may be placed differently than expected. The most common phenomenon that is
that Objects are not updated when a parameter is changed in Grasshopper. In case of Doors/
Windows, the settings dialog can misbehave when you try to edit the elements manually.
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Recommendation: Do not use Grasshopper to modify multiple GDL parameters simultaneously
if their values are interdependent.
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